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1 Przegląd
1.1 Konstrukcja modułowa

System Access Professional Edition (w dalszej części dokumentu nazywany w skrócie Access
PE) to kompleksowe, autonomiczne rozwiązanie do kontroli dostępu dla firm małej i średniej
wielkości. Składa się ono z kilku modułów:
– Usługa LAC: proces, który polega na ciągłej komunikacji z lokalnymi kontrolerami dostępu

LAC (ang. Local Access Controllers, w dalszej części dokumentu nazywanych
kontrolerami). AMC: modułowe kontrolery dostępu (ang. Access Modular Controllers),
które są stosowane jako kontrolery.

– Configurator (Konfigurator)
– Personnel Management (Zarządzanie personelem)
– Log Viewer (Analiza dziennika)
– Alarm Management (Zarządzanie alarmami)
– Video Verification (Weryfikacja wideo)

1.2 Moduły serwera i klienta
Składniki te można podzielić na moduły instalowane i pracujące na serwerze i na klientach.
Usługa LAC musi pozostawać w stałej łączności z kontrolerami, ponieważ po pierwsze, stale
otrzymuje od nich komunikaty o ruchach, obecności i nieobecności użytkowników, po drugie,
przesyła do kontrolerów zmiany dotyczące danych, np. związane z przyznaniem nowych kart,
ale głównie dlatego, że przeprowadza kontrole metapoziomowe (sekwencyjne kontrole
dostępu, kontrole funkcji zapobiegającej przekazaniu karty osobie niepowołanej, kontrole
losowe).
Aplikacja Configurator (Konfigurator) również powinna pracować na serwerze, jednak można
ją też zainstalować na klienckich stacjach roboczych i obsługiwać z ich poziomu.
Moduły Personnel Management (Zarządzanie personelem) i Log Viewer (Analiza dziennika)
należą do składników klienta i mogą być uruchamiane dodatkowo na serwerze lub na innym
komputerze połączonym przez sieć z serwerem.
Istnieje możliwość zastosowania następujących kontrolerów:
– AMC2 4W (z czterema interfejsami czytników Wiegand) — można rozszerzyć za pomocą

modułu AMC2 4W-EXT
– AMC2 4R4 (z czterema interfejsami RS485 do czytników)
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2 Informacje ogólne
2.1 Wstęp

Access PE to system kontroli dostępu, który został zaprojektowany z myślą o nadzorowaniu
małych i dużych obiektów o wysokich wymaganiach w zakresie bezpieczeństwa i
elastyczności.
Swą dużą niezawodność oraz możliwości w zakresie rozbudowy Access PE zawdzięcza
koncepcji trzech platform: nadrzędną platformą jest platforma administracyjna wraz z
usługami kontrolnymi. Na tej płaszczyźnie wykonywane są wszystkie zadania administracyjne,
np. rejestracja nowych kart oraz przydzielanie uprawnień dostępu.
Druga platforma tworzona jest przez lokalne kontrolery dostępu (LAC) nadzorujące każdą
grupę drzwi lub wejść. Nawet jeśli system działa w trybie offline, kontroler LAC jest zdolny do
niezależnego podejmowania decyzji w zakresie kontroli dostępu. Kontrolery LAC są
odpowiedzialne za prawidłowy przebieg procedur na przejściach, nadzorując np. czas otwarcia
drzwi lub pytając o kod PIN przy wejściach o znaczeniu krytycznym.
Trzecia platforma składa się z czytników kart.
Komunikacja między klientem, serwerem a posiadaczami kart jest zaszyfrowana za pomocą
mechanizmu AES.
Wersja wielostanowiskowa oprogramowania Access PE umożliwia kontrolowanie systemu z
różnych stanowisk. Zróżnicowane poziomy uprawnień regulują dostęp użytkowników do
systemu i są gwarancją bezpieczeństwa. Dlatego też np. na jednym stanowisku można
zarządzać kartami, a na innym skontrolować, czy dany pracownik jest obecny w budynku.
System Access PE umożliwia niezwykle elastyczną konfigurację uprawnień dostępu, modeli
czasowych oraz parametrów wejść. Poniższe zestawienie stanowi przegląd jego
najważniejszych funkcji:
Szybkie i łatwe przydzielanie kart identyfikacyjnych
Przydzielenie karty (do trzech) danej osobie odbywa się poprzez wprowadzenie danych
ręcznie lub za pośrednictwem czytnika cyfrowego, połączonego z komputerem za pomocą
interfejsu szeregowego. Wszystkie przypisane karty są aktywne. W przypadku wymiany karty
identyfikacyjnej stara karta zostaje automatycznie zastąpiona nową i traci swoją ważność;
dzięki temu nie zdarzy się sytuacja, że stara karta, która przez nieuwagę lub z powodu
niemożności anulowania nie została dezaktywowana, będzie nadal wykorzystywana.
Uprawnienia dostępu (również dla grup)
Jedna osoba może otrzymać zarówno uprawnienia grupowe, jak i uprawnienia indywidualne.
Uprawnienia można ograniczyć co do obszaru jak i czasowo, z dokładnością co do minuty.
Uprawnienia grupowe można wykorzystać do przydzielania i ograniczania uprawnień dostępu
dla dowolnego posiadacza identyfikatora lub dla wszystkich posiadaczy jednocześnie.
Uprawnienia grupowe mogą zostać uzależnione od modeli czasowych, ograniczających ich
działanie do wybranych godzin w ciągu dnia.
Śledzenie dostępu
Dzięki definiowaniu stref można nadzorować i wymuszać prawidłową kolejność przejść. Nawet
bez monitorowania, za pomocą tej konfiguracji można wyświetlić miejsce przebywania
posiadacza karty.
Funkcja zapobiegająca przekazaniu karty osobie niepowołanej
Jeśli dana karta została odczytana, wówczas przez określony czas nie może być ponownie
użyta w tym samym przejściu. Dzięki temu użytkownik po przejściu bramki nie będzie mógł
przekazać swojej karty nieuprawnionej osobie, umożliwiając w ten sposób niedozwolone
przejście.
Automatyczna blokada kart po upływie terminu ważności
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Goście oraz pracownicy tymczasowi często wymagają dostępu tylko przez ograniczony czas.
Wystawiając kartę można określić jej okres ważności. Po upływie terminu karta automatycznie
traci ważność.
Modele czasowe i modele dzienne
Każdej osobie można przydzielić modele czasowe, które decydują o tym, w jakim czasie wstęp
jest dozwolony. Modele czasowe można zdefiniować elastycznie, przydzielając modele dzienne
określające, które dni tygodnia, weekendy, dni świąteczne i dni specjalne różnią się od dni
normalnych.
Identyfikacja na podstawie kodu PIN
Zamiast karty można używać specjalnego kodu PIN, który należy wprowadzić.
Weryfikacja za pomocą kodu PIN
Dla obszarów ściśle chronionych można zdefiniować konieczność wprowadzenia dodatkowych
kodów PIN. Funkcję tą można także połączyć z modelami czasowymi, np. aby podanie kodu
PIN wymagane było wyłącznie poza godzinami pracy lub w dni wolne.
Elastyczne zarządzanie drzwiami
Elastyczne przydzielanie parametrów do poszczególnych modeli drzwi zapewnia optymalną
równowagę między bezpieczeństwem i komfortem. Dla każdego wejścia można zdefiniować
czas otwarcia, zanim alarm zostanie uruchomiony. Wbudowana instalacja alarmowa może,
opcjonalnie, zablokować przejście.
Okresowe otwarcie drzwi
Dla ułatwienia dostępu wybrane drzwi można na określony czas ustawić w trybie stałego
zezwolenia. Takie zezwolenie może być przydzielone ręcznie lub automatycznie za
pośrednictwem modelu czasowego.
Czas i udział
Punktom dostępu można przyporządkować parametry zapisu czasu wejścia oraz wyjścia
pracowników w celu kontroli czasu pracy.
Tworzenie karty
Dzięki dodatkowemu modułowi o nazwie Personalizacja kart (CP) system kontroli dostępu
zintegrowano z oprogramowaniem do wystawiania kart identyfikacyjnych, co umożliwia
operatorowi tworzenie takich kart bez przełączania się do innych aplikacji.
Przypisywanie zdjęć
Jeśli moduł dodatkowy Personalizacja kart (CP) nie został aktywowany, nie można
importować i przypisywać identyfikatora fotograficznego do posiadacza karty.
System blokowania offline
Strefy nieobjęte, z jakiegokolwiek powodu, systemem kontroli dostępu online o wysokiej
dostępności mogą być blokowane w trybie offline.
Zarządzanie urządzeniami wizyjnymi
Wejścia można dodatkowo wyposażyć w kamery do identyfikacji i śledzenia ruchów osób,
które z tych wejść korzystają.

2.2 Logowanie użytkownika
Dostępne są poniższe aplikacje. Szczegółowe informacje na ich temat można znaleźć
w poszczególnych instrukcjach obsługi:

Zarządzanie personelem



8 pl | Informacje ogólne Access Professional Edition

2019-07 | | Instrukcja konfiguracji Bosch Security Systems B.V.

Konfigurator

Analiza dziennika

Zarządzanie mapami i alarmami

Weryfikacja wideo

Uwaga!
Logowanie przez klienta możliwe jest tylko, gdy na serwerze aktywna jest licencja LAC.

Logowanie klienta
Aplikacje systemu są chronione przed nieuprawnionym użyciem. Domyślne dane
uwierzytelniające, które służą do pierwszego uruchomienia:
– Nazwa użytkownika: bosch
– Hasło: bosch

Po wpisaniu prawidłowych danych w polach Nazwa użytkownika/Hasło, uaktywniony zostanie
przycisk Zmień hasło.
Po 3 nieudanych próbach, dostęp do systemu zostanie na pewien czas ograniczony. Dotyczy to
przycisków „Uruchom aplikację” oraz „Zmień hasło”.
Na górnej liście rozwijanej można wybrać odpowiedni język. Domyślnie stosowany jest język
wybrany podczas instalowania aplikacji. W przypadku zmiany użytkownika bez restartowania
aplikacji zachowany zostanie ostatnio używany język. Z tego powodu okno logowania może się
wyświetlić się w nieprawidłowym języku. Aby tego uniknąć, należy ponownie zalogować się w
systemie Access PE.
Aplikacje systemu Access PE można uruchomiać w następujących językach:
– angielski,
– niemiecki,
– francuski,
– japoński,
– rosyjski,
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– polski,
– chiński (ChRL),
– niderlandzki,
– hiszpański,
– portugalski (Brazylia).

Uwaga!
Wszystkie ustawienia, tj. nazwy urządzeń, etykiety, modele oraz uprawnienia, będą
wyświetlane w języku, w którym zostały wprowadzone. Również przyciski i etykiety
obsługiwane przez system operacyjny będą wyświetlane w języku instalacji systemu.

Po kliknięciu przycisku Zmień hasło wpisz nową nazwę użytkownika i hasło w oknie
dialogowym:

Uwaga!
Należy pamiętać, aby zmienić domyślne hasło!

Z kolei użycie przycisku Uruchom aplikację powoduje skontrolowanie uprawnień użytkownika i
ewentualne uruchomienie aplikacji. Jeśli kontrola uprawnień wypadnie negatywnie, pojawi się
komunikat o błędzie Wrong username or password! (Nieprawidłowa nazwa użytkownika lub
hasło!).
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2.3 Układ okna dialogowego Zarządzanie personelem
Okno dialogowe składa się z następujących elementów:

1 = Pasek menu — zawiera funkcje okna dialogowego
wyświetlane zgodnie z porządkiem menu.

2 = Pasek narzędzi — zawiera przyciski skrótów do
najważniejszych funkcji okna dialogowego.

3 = Pasek tytułu — odpowiada standardowi systemu
Windows i zawiera przyciski do minimalizacji oraz
zamykania okna dialogowego. Nazwa zalogowanego
użytkownika jest widoczna w nawiasach kwadratowych.

4 = Tabela osób — zawiera listę osób ujętych w systemie
wraz z ich stanem uczestnictwa (uprawnienia i
lokalizacja).

5 = Pole dialogowe — przy pierwszym otwarciu tego pola
lub gdy nie jest zalogowany żaden użytkownik, widoczny
jest neutralny obraz. Po wybraniu pozycji na liście osób
wyświetlone zostaną dane tej osoby.

6 = Karty użyte online — zawiera listę pięciu ostatnich osób
(wraz z ich zdjęciem z bazy danych), które przesunęły
swoje karty w czytnikach przy wybranych wejściach.

7 = Stan urządzenia — lista skonfigurowanych urządzeń i
wejść oraz ich stan połączenia. Udostępnia funkcje
sterowania drzwiami.

8 = Wyświetlanie zdarzeń — awarie są sygnalizowane przez
migający czerwony pasek (miga trzy razy), który zawiera
szczegóły wyjaśniające przyczynę nieprawidłowości.
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9 = Pasek stanu — zawiera informacje o przyciskach i
pozycjach menu obsługiwanych za pomocą kursora.
Wskazanie stanu programu do personalizacji kart (CP),
czytników z wyświetlaczem oraz usług LAC.

2.4 Pasek narzędzi modułu Zarządzanie personelem
Poniższe funkcje są dostępne za pośrednictwem menu oraz przycisków na pasku narzędzi.

Funkcja Ikona Opis

Menu Opcje

Refresh (Odśwież) Aktualizuje listę osób.

Exit (Zakończ) Zamyka aplikację Access PE —
Zarządzanie personelem.

Menu Osoby

Nowa osoba Otwiera okno dialogowe danych
osobowych i kart
identyfikacyjnych z pustymi
polami.

Edytuj osobę Otwiera okno dialogowe danych
osobowych i kart
identyfikacyjnych z danymi
wybranej osoby.

Usuń osobę Usuwa zaznaczoną osobę po
potwierdzeniu wyświetlonego
zapytania.

Wyślij wybraną
osobę do usługi
LAC

Wysyła dane wybranej osoby do
usługi LAC i raportuje
powodzenie.

Wyślij wszystkie
osoby do usługi
LAC

Wysyła dane wszystkich osób
do usługi LAC i raportuje
powodzenie.

Ustaw
nieobecność
wszystkich osób

Po potwierdzeniu
wyświetlonego zapytania
ustawia nieobecność wszystkich
osób.

Ustaw lokalizację
wszystkich
obecnych jako
nieznaną

Ustawia lokalizację wszystkich
osób jako nieznaną i
dezaktywuje śledzenie dostępu
dla następnych zgłoszeń każdej
z tych osób.

Oczyszczanie z
osób

Wywołuje okno dialogowe, aby
wyczyścić bazę danych osoby
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Funkcja Ikona Opis

Przeglądaj/drukuj
raporty

Otwiera okno dialogowe z
funkcją tworzenia list raportów.

Sterow
anie
listami

Ogranicza wyświetlanie osób na
liście do wybranych grup
personelu.

Menu Widok

Pasek narzędzi Wyświetla lub ukrywa pasek
narzędzi. Wartość domyślna =
włączony.

Pasek stanu Wyświetla lub ukrywa pasek
stanu. Wartość domyślna =
włączony.

Dane osobowe:
State (Stan)
Numer karty
Numer personalny
Company (Firma)
Grupa personelu
Phone (Telefon)
Location
(Lokalizacja)

Wybór kolumn, które zostaną
dodatkowo wyświetlone w
przeglądzie osób obok kolumn
symbolów i nazw.
Domyślnie = Stan — Firma —
Lokalizacja

Menu Zarządzanie drzwiami

Otwórz drzwi Te
funkcje
są
równie
ż
dostęp
ne w
menu
kontek
stowym
(prawy
klawisz
myszy)
poszcz
ególnyc
h
drzwi/
wejść.

Zaznaczone na liście urządzeń
wejście zostanie wyświetlone i
może zostać otwarte
(jednorazowo).

Otwórz na stałe Zaznaczone na liście urządzeń
wejście zostanie wyświetlone i
może zostać otwarte (na stałe).

Zamknij drzwi Zaznaczone na liście urządzeń
wejście zostanie wyświetlone i
może zostać zamknięte.

Menu Narzędzia
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Funkcja Ikona Opis

Logowanie
użytkownika

Zarządzanie personelem —
logowanie/wylogowywanie.

Uruchom
Konfigurator

Uruchamia aplikację
Konfigurator i przesyła do niej
dane z aplikacji zarządzania
personelem.

Uruchom analizę
dziennika

Uruchamia aplikację Analiza
dziennika i przesyła do niej
dane z aplikacji zarządzania
personelem.

Uruchom
weryfikację wideo

Otwiera aplikację do weryfikacji
wideo.

Uruchom
zarządzanie
alarmami i
mapami

Otwiera aplikację Przeglądanie
map i zarządzanie alarmami

Panel wideo Pokazuje w oknie dialogowym
cztery ekrany odpowiadające
poszczególnym sygnałom
wizyjnym z kamer.

Właściwości Otwiera okno dialogowe do
ustawiania parametrów
ogólnych systemu.

Menu ? (Pomoc)

Tematy pomocy Otwiera ten plik pomocy.

About Access
Professional
Edition -
Personnel
Management
(Informacje o
aplikacji
Zarządzanie
personelem
systemu Access
Professional
Edition)

Umożliwia otwieranie okna z
informacjami o aplikacji
Personnel Management
(Zarządzanie personelem).



14 pl | Informacje ogólne Access Professional Edition

2019-07 | | Instrukcja konfiguracji Bosch Security Systems B.V.

2.4.1 Oczyszczanie z osób
Jeśli chcesz usunąć osoby, które nie są już wymagane w systemie, wybierz z menu rozwijanego
Persons (Osoby) polecenie Cleanup persons (Oczyszczanie z osób)

Na liście wyświetli się pewna liczba osób. Istnieje możliwość wyboru ich przez różne kryteria
filtrowania. Osoby mające prawa użytkownika nie będą wyświetlane. Poniższy przykład odnosi
się do osób bez przypisanej karty.
– Wybierz osoby, które chcesz usunąć.
– Kliknij na dole przycisk Delete selected persons (Usuń wybrane osoby).
– Kliknij symbol wyszukiwania, aby zaktualizować wybór.

2.5 Zmiana konfiguracji

2.5.1 Zmiana konfiguracji czytników rejestracji
1. Otwórz aplikację Access PE Personnel Management.
2. Na pasku menu aplikacjiAccess PE Personnel Management kliknij przycisk Narzędzia.
3. Na liście rozwijanej kliknij pozycję Właściwości.
– Otworzy się okno dialogowe Zmień konfigurację.
– Należy pamiętać, że w oknie dialogowymZmień konfigurację tylko pierwsza sekcja odnosi

się do czytnika rejestracji.
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4. Sparametryzuj i skonfiguruj dane czytnika rejestracji zgodnie ze specyfikacjami
producenta.

Uwaga!
Po podłączeniu czytnika rejestracji do stacji dialogowej ręczna rejestracja danych karty jest
tymczasowo zablokowana.

Poniżej podano wymagane ustawienia dla obsługiwanych czytników rejestracji:

Typ czytnika Typ karty Szybkoś
ci
transmisj
i

Parzysto
ść

Bity
danych

Bity
Stopu

LECTUS enroll 5000 MD – Zapis
danych MIFARE

– Kod Bosch
(63-bitowy)

– Numer
seryjny karty
(CSN)

9600 brak 8 1

Interflex USB Hitag, Mifare – Kod Bosch
(63-bitowy)

– Numer
seryjny karty
(CSN)

Czytniki AMC Wiegand, 4R4

Rosslare ARD-1200EM USB 9600 brak 8 1

DELTA 1200 Prox RS232 9600 brak 8 1

DELTA 1200 iClass RS232 57600 Parzyste 8 1
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Typ czytnika Typ karty Szybkoś
ci
transmisj
i

Parzysto
ść

Bity
danych

Bity
Stopu

DELTA 1200 USB Hitag, Legic,
Mifare

9600 brak 8 1

DELTA 1200 RS232 Hitag, Legic,
Mifare

19200 brak 8 1

Uwaga!
Czytniki Delta 1200 Series i Rosslare ARD-1200EM Series nie zostały poddane ocenie przez
firmę UL.

2.5.2 Dopuszczanie i blokowanie funkcji personalizacji kart
Jeśli system został zainstalowany wraz z opcjonalnym programem do wystawiania kart Card
Personalization (Personalizacja kart), połączenie z nim jest domyślnie zaznaczone w
ustawieniach.
1. Otwórz aplikację Access PE Personnel Management.
2. Na pasku menu aplikacjiAccess PE Personnel Management kliknij przycisk Narzędzia.
3. Na liście rozwijanej kliknij pozycję Właściwości.
– Otworzy się okno dialogowe Zmień konfigurację.
4. Zaznacz pole wyboru System CP personalizacji kart, aby umożliwić dostęp do wszystkich

funkcji personalizacji kart.
5. Wyczyść pole wyboru System CP personalizacji kart, aby zablokować dostęp do

wszystkich funkcji personalizacji kart.

2.5.3 Łączenie i rozłączanie się z usługą LAC
1. Otwórz aplikację Access PE Personnel Management.
2. Na pasku menu aplikacjiAccess PE Personnel Management kliknij przycisk Narzędzia.
3. Na liście rozwijanej kliknij pozycję Właściwości.
– Otworzy się okno dialogowe Zmień konfigurację.
4. Pole wyboru Połącz z usługą LAC jest domyślnie zaznaczone (zalecane). Umożliwia to

połączenie z usługą LAC.
5. Usuń zaznaczenie pola wyboru Połącz z usługą LAC, aby odłączyć usługę LAC.

Uwaga!
Jeśli usługa LAC zostanie odłączona, komunikaty od i do usługi nie zostaną udostępnione (np.
przesunięcie w trybie online)

2.5.4 Włączanie i wyłączanie okna dialogowego edycji i wyświetlanie informacji
o karcie wewnętrznej
Okno dialogowe edycji i wyświetlania informacji o karcie wewnętrznej jest potrzebne, gdy
konfiguracja danych karty musi być zmieniona zgodnie z standardowymi ustawieniami firmy.
1. Otwórz aplikację Access PE Personnel Management.
2. Na pasku menu aplikacjiAccess PE Personnel Management kliknij przycisk Narzędzia.
3. Na liście rozwijanej kliknij pozycję Właściwości.
– Otworzy się okno dialogowe Zmień konfigurację.
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4. Zaznacz pole wyboru Nie wyświetlaj okna dialogowego edycji i wyświetlania informacji
o karcie wewnętrznej, aby wyłączyć to okno.

5. Wyczyść pole wyboru Nie wyświetlaj okna dialogowego edycji i wyświetlania informacji
o karcie wewnętrznej, aby włączyć to okno.

2.5.5 Włączanie i wyłączanie czcionek THAI w przypadku raportów (użyj czcionki
specjalnej)
1. Otwórz aplikację Access PE Personnel Management.
2. Na pasku menu aplikacjiAccess PE Personnel Management kliknij przycisk Narzędzia.
3. Na liście rozwijanej kliknij pozycję Właściwości.
– Otworzy się okno dialogowe Zmień konfigurację.
4. Zaznacz pole wyboru Włącz czcionkę THAI dla raportów (użyj czcionki specjalnej), aby

włączyć w raportach język i czcionki tajskie.
5. Zaznacz pole wyboru Włącz czcionkę THAI dla raportów (użyj czcionki specjalnej), aby

włączyć w raportach język i czcionki tajskie.

Uwaga!
Ta funkcja jest dostępna tylko w przypadku ustawienia języka angielskiego.

2.5.6 Rejestracja za pomocą czytników podłączonych do kontrolera AMC
Upewnij się, że przynajmniej jeden czytnik jest skonfigurowany za pomocą opcji Model drzwi
06c, który jest modelem drzwi do rejestracji.
– Uruchom Configurator i wybierz kontroler LAC (np. AMC2 Wiegand)

Kliknij symbol Wejścia, aby dodać nowy czytnik wejścia:
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Pojawi się okno dialogowe Entrances (Wejścia):

W tym oknie dialogowym można:
– Wprowadzić opis (np. Enrollment Reader AMC)
– Wybrać LAC i ID grupy (GID)
– Wybrać typ czytnika (np. Wiegand)
– Wybrać numer od 1 do 8 jako adres czytnika dostępu
Kliknij OK, aby potwierdzić konfigurację rejestracji.

Aby przypisać konfigurację czytnika do konkretnej stacji roboczej, należy przejść do ustawień
klienta APE.
– Narzędzia > Właściwości.
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Aby aktywować proces rejestracji, wybierz dostępny czytnik rejestracji.
Upewnij się, że wybrany czytnik rejestracji jest w trybie online.
Jeżeli nie będzie natychmiastowej reakcji, ponownie uruchom okno dialogowe Zarządzanie
personelem.
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3 Zarządzanie personelem
To okno dialogowe to główna aplikacja stacji roboczych. Oprócz przechowywania danych i
edytowania ustawień do zadań tego okna dialogowego należy również pokazywanie lokalizacji
poszczególnych osób, a także zastosowanych wobec nich blokad. Można też przeprowadzić
procesy monitoringu systemu za pomocą funkcji sterowania drzwiami i wyświetlania stanu
urządzeń.

3.1 Lista osób
Lista osób zawiera wykaz wszystkich osób wprowadzonych do systemu. Domyślnie lista
zawiera nazwisko, imię oraz nazwę firmy lub działu. W osobnej kolumnie symboli znajdują się
szczegóły dotyczące stanu osoby lub karty identyfikacyjnej o następującym znaczeniu:

Ta osoba nie ma karty

Ta osoba jest nieobecna.

Ta osoba jest obecna.

Ta osoba jest nieobecna i zablokowana. W oknie
dialogowym widoczne jest dodatkowo migające
światło.

Ta osoba jest obecna i zablokowana. W oknie
dialogowym widoczne jest dodatkowo migające
światło.

Domyślny widok listy (kolumny Symbol, Name (Imię i nazwisko) oraz Company/Dept. (Firma/
Dział) można ustawić indywidualnie dla każdej stacji roboczej. Polecenia menu View >
Personnel Data (Widok > Dane osobowe) można używać do dodawania lub usuwania kolumn.
Wyświetlane kolumny są oznaczone znacznikiem, a ponowny jego wybór włącza lub wyłącza
ich wyświetlanie.
Dostępne są następujące kolumny dodatkowe:
– Numer karty
– Numer personalny
– Firma/Dział
– Grupa personelu
– Telefon
– Lokalizacja (jeśli określono opcję Areas (Obszary))
– Picture (Zdjęcie)
– Last access (Ostatni dostęp)
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Uwaga!
Bieżąca szerokość pola listy może nie pozwalać na wyświetlenie wszystkich wybranych
kolumn. W takim przypadku należy odpowiednio zmienić szerokość i kolejność kolumn.
Kolejność kolumn można zmienić, przesuwając i upuszczając nagłówki kolumn. Oczywiście
zwiększenie szerokości listy osób wpływa na szerokość pola dialogowego znajdującego się na
prawo od niej.

Pasek narzędzi zawiera pole wyboru służące do filtrowania listy osób. Domyślnie wyświetlane
są wszystkie osoby w grupach Employees (Pracownicy) lub Visitors (Goście).

Uwaga: w przypadku utworzenia dodatkowej grupy (np. dla VIP-ów) jej członkowie będą
automatycznie wyświetlani w grupie Employees (Pracownicy).
Do listy osób można dodać kolumnę Picture (Zdjęcie). Kolumnę tę można ukrywać i
wyświetlać za pomocą menu View > Personnel data > Picture (Widok > Dane osobowe >
Zdjęcie).
Ponieważ ta kolumna znajduje się w skrajnej prawej pozycji, czasami konieczne jest
przewinięcie listy osób, aby kolumna była widoczna. Może zaistnieć potrzeba ukrycia innych
kolumn.

Uwaga!
Zdjęcia są dopasowywane do wysokości kolumny, więc identyfikacja osób może być trudna,
jeśli ekran jest mały. Dlatego głównym powodem wyświetlania zdjęć jest umożliwienie
użytkownikom szybkiego sprawdzenia, które osoby nie mają jeszcze swojej fotografii w
pamięci systemu.
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3.2 Okno dialogowe danych osobowych
Wybranie pozycji na liście osób powoduje wyświetlenie odpowiednich danych osobowych w
oknie dialogowym po prawej stronie.

To okno dialogowe oprócz tego, że wyświetla najważniejsze dane osobowe, umożliwia
wywoływanie wielu różnych funkcji.

Wyświetlanie/Funkcja Opis

Name (Imię i nazwisko)
(tytuł, imię, nazwisko)

Tylko wyświetlanie — wprowadzanie
zmian umożliwia okno dialogowe
edycji — Personnel and card data
(Dane osobowe i karty
identyfikacyjnej), Strona 34.

Company/Dept. (Firma/
Dział)

Personnel-No. (Numer
personalny)

Card-No. (Numer karty)

Photo (Zdjęcie)

Current Status (Bieżący
stan)

Wskazanie obecności/nieobecności
wraz z datą.

Set present, Set absent
(Ustaw obecność,
ustaw nieobecność)

W zależności od bieżącego stanu
daną osobę można tu określić jako
obecną lub nieobecną.

Notes (Uwagi) Miejsce na wprowadzenie
dowolnego tekstu z informacjami na
temat danej osoby. Maksymalnie 50
znaków.
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Wyświetlanie/Funkcja Opis

Memo (Notatka) Miejsce na wprowadzenie
dowolnego tekstu dotyczącego
danej osoby. Maksymalnie 300
znaków.

Memo preview/Print
Memo (Podgląd
notatki/Drukuj notatkę)

Tekst notatki można wyświetlić lub
wydrukować zgodnie ze wstępnie
zdefiniowanym układem wydruku.

Telephone (Telefon) Telefon, pod którym dana osoba
jest osiągalna.

Location (Lokalizacja) Wyświetlanie i modyfikacja miejsca
pobytu osoby. Można wybrać
dowolny obszar, a także wartość
domyślną -- unknown -- (nieznany).

Komunikaty specjalne
na czytniku

każdy wiersz wyświetlacza może
zawierać maksymalnie 20 znaków

Name (Imię i nazwisko) Imię i nazwisko osoby, w postaci
wyświetlanej na odpowiednio
wyposażonych czytnikach kart.

On arrival (Na wejście) Specjalny tekst powitalny.

On leaving (Na wyjście) Specjalny tekst pożegnalny.

Card status (Stan karty)

– valid (ważna)
– explicitly blocked

(zablokowana
jawnie)

– 3x wrong PIN input
(3 x błędny PIN)

– Selected for
random screening
(Wybrana do
losowej kontroli)

Wyświetlanie i modyfikacja stanu
karty identyfikacyjnej. Można tu
ustawić poniższe parametry karty.

3.3 Stan urządzeń
W trzecim obszarze głównego okna dialogowego zarządzania personelem, znajdującym się
poniżej listy osób, jest wyświetlany stan skonfigurowanych urządzeń.
Obok listy komunikatów dziennika wyświetlany jest obszar stanu urządzeń.
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Do wskazania stanu urządzenia służą następujące symbole:

Stan urządzeń Symbol

Kontroler działa w trybie online

Kontroler działa w trybie offline

Nie można nawiązać połączenia z kontrolerem

Połączenie z czytnikiem — OK

Połączenie z czytnikiem jest wadliwe

Nie można nawiązać połączenia z czytnikiem.

Tryb pracy/
stan drzwi

Symbol stanu 
normalnego

Symbol stanu
stałego otwarcia

Symbol stanu
stałego zablokowania

Zamknięte

Otwarte normalnie nie dot.

Limit czasu otwarcia nie dot. nie dot.

Otwarte przerwane nie dot.

Nieznany

Uszkodzone

Na wadliwe połączenie wskazuje dodatkowo pasek u dołu okna dialogowego, migający na
czerwono podczas otwierania tego okna.
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Uwaga!
W przypadku czytników Wiegand może się zdarzyć, że wskazanie stanu będzie nieprawidłowe.
Ponieważ nie potrafią one odpowiadać na żądania dotyczące stanu, skonfigurowany czytnik
Wiegand będzie wyświetlany jako znajdujący się w trybie online, dopóki jego kontroler
znajduje się w trybie online.

Elementy sterujące
Ta funkcja jest aktywna tylko wtedy, gdy aktualnie zalogowany użytkownik ma uprawnienia do
sterowania drzwiami — Uprawnienia użytkownika.
Ta funkcja jest aktywna tylko wtedy, gdy aktualnie zalogowany użytkownik ma uprawnienia do
sterowania drzwiami.
Za pomocą menu kontekstowego (otwieranego przez kliknięcie prawym przyciskiem myszy)
zaznaczonych urządzeń lub menu Door management (Sterowanie drzwiami) można wydawać
polecenia sterowania urządzeniom, z którymi jest nawiązane połączenie.

Nazwa wybranego wejścia jest odczytywana z kontekstu.

Open <Entrance> (Otwórz
<wejście>)

Wybrane wejście otwiera się raz
(dla jednej osoby).

Long-term open <Entrance>
(Otwórz na długo <wejście>)

Wybrane wejście otwiera się na
dłuższy czas.

Lock <Entrance> (Zablokuj
<wejście>)

Wybrane wejście zostaje
zablokowane.
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3.4 Korzystanie z przesunięcia online
Przesunięcia online to funkcja wyświetlająca historię dostępu oraz stany drzwi jednego lub
więcej wybranych wejść.

W okienku tej funkcji wyświetli się maksymalnie 400 zdarzeń z ostatnich 48 godzin, jakie
wydarzyły się na wybranych wejściach. Zdarzenia są wyświetlane w czasie rzeczywistym.
W przypadku każdej osoby, która korzysta z interfejsu wejścia (np. prezentuje poświadczenie),
w okienku Przesunięcie online wyświetlane są następujące informacje:
– Zdjęcie
– Data
– Godzina
– Nazwa wejścia
– Zdarzenia drzwi
– Decyzja systemu dotycząca dostępu

Kolory kresek pionowych po lewej stronie zdarzenia mają następujące znaczenie:

Kolor Znaczenie

Zielony Udzielono dostępu

Czerwony Odmowa dostępu

Wyczyść Komunikaty systemowe/ostrzeżenia

3.4.1 Otwieranie funkcji przesunięcia online
1. Otwórz aplikację Access PE Personnel Management.
– Zostanie otwarte główne okno aplikacji.
2. Wybierz wejście w drzewie urządzeń.
3. Kliknij prawym przyciskiem myszy wybrane wejście.
4. W menu kontekstowym wybierz opcję Przesunięcie online.
– Po prawej stronie głównego okna aplikacji pojawi się okienko przesunięcia online.
– W okienku tej funkcji wyświetli się maksymalnie 400 zdarzeń z ostatnich 48 godzin, jakie

wydarzyły się na wybranym wejściu.
– Każde wejście, które ma być wyświetlane w okienku przesunięcia online, jest w drzewie

urządzeń oznaczone gwiazdką.
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Aby wyświetlić historię dostępu do dodatkowego wejścia, należy jawnie wybrać pozycję
Przesunięcie online w menu kontekstowym żądanego wejścia w drzewie urządzeń.

Uwaga!
Po wybraniu innego wejścia w drzewie urządzeń historia dostępu do poprzednio wybranych
wejść pozostaje nadal w okienku przesunięcia online.

3.4.2 Ukrywanie i wyświetlanie okienka przesunięcia online
Opcja 1
1. W drzewie urządzeń wybierz aktywne wejście (oznaczone gwiazdką).
2. Kliknij prawym przyciskiem myszy wybrane wejście.
3. Wybierz opcję Ukryj przesunięcia online, aby ukryć okienko przesunięcia online.
– Wszystkie wybrane wejścia pozostaną w drzewie urządzeń nadal oznaczone gwiazdką.
Opcja 2
1. Na pasku menu aplikacji Access PE Personnel Management kliknij przycisk Wyświetl.
2. Wybierz opcję Ukryj przesunięcia online, aby ukryć okienko przesunięcia online.
– Wszystkie wybrane wejścia pozostaną w drzewie urządzeń nadal oznaczone gwiazdką.

3.4.3 Wyłączanie okienka przesunięcia online
1. Na pasku menu aplikacji Access PE Personnel Management kliknij przycisk Wyświetl.
2. Wybierz opcję Wyłącz przesunięcie online, aby wyłączyć funkcję przesunięcia online.
– Wszystkie wybrane wejścia są resetowane, a gwiazdki znikają.

3.4.4 Konfigurowanie opcji wyświetlania informacji o przesunięciach online
Opcja 1
1. Na pasku menu aplikacji Access PE Personnel Management kliknij przycisk Wyświetl.
2. Wybierz opcję Przesunięcie online z...
– Pojawi się podmenu z trzema opcjami wyświetlania informacji. Można wybrać następujące

opcje:
– Wyświetl komunikaty o osobach
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– Wyświetl komunikaty z wejść
– Wyświetl komunikaty czytników

3. Wybierz jedną lub więcej opcji wyświetlania informacji.
– Zostaną wyświetlone tylko wybrane opcje wyświetlania informacji o przesunięciach

online.

Opcja 2
1. W okienku Przesunięcia online kliknij prawym przyciskiem myszy komunikat zdarzenia.
– Pojawi się menu kontekstowe z trzema opcjami wyświetlania informacji. Można wybrać

następujące opcje:
– Wyświetl komunikaty o osobach
– Wyświetl komunikaty z wejść
– Wyświetl komunikaty czytników

2. Wybierz jedną lub więcej opcji wyświetlania informacji.
– Zostaną wyświetlone tylko wybrane opcje wyświetlania informacji o przesunięciach

online.
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3.5 Zarządzanie danymi wizyjnymi
Komponenty wideo zintegrowane z systemem kontroli dostępu Access Professional Edition
mogą na wejściach specjalnie chronionych pełnić funkcję dodatkowych urządzeń kontrolnych,
służących do porównywania obrazów na żywo z obrazami przechowywanymi w bazie danych
oraz do kontroli otoczenia. Możliwe jest także wygenerowanie specjalnych alarmów z
wykorzystaniem nagrań wideo i monitorowanie określonych stref, nawet niezwiązanych
bezpośrednio z wejściami.
Poza tym komponenty wideo mogą być dostępne i używane w systemie Access PE w
następujących strefach:
– Weryfikacja wideo: dodatkowe, optyczne elementy sterujące przy wejściach.
– Zarządzanie alarmami: specjalnie skonfigurowane komunikaty alarmowe i wpisy mogą być

wspomagane zarejestrowanymi sekwencjami wideo.
– Prezentacje wideo: odtwarzanie bieżącego obrazu jednocześnie z maksymalnie czterech

kamer z możliwością swobodnej konfiguracji.

Więcej informacji
– Panel wideo, Strona 29
– Obraz na żywo, Strona 31

3.5.1 Panel wideo

Kliknięcie przycisku  na pasku narzędzi aplikacji Personnel Management (Zarządzanie
personelem) spowoduje zastąpienie pola dialogowego ekranem przedstawiającym cztery
widoki.
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Na panelu wideo można wybrać maksymalnie cztery kamery związane z różnymi wejściami.
Dla każdego okna dostępne są następujące funkcje:

Lista wyboru Można wybrać dowolną kamerę załadowaną
do systemu kontroli dostępu i w każdej
chwili ją wymienić.

Przechowuje zatrzymany obraz bieżącego
widoku jako <nazwa
urządzenia>_rrrrMMddggmmsstttt.jpg w
lokalizacji C:\BOSCH\Access Professional
Edition\PE\Data\Video (ścieżka domyślna).

Rozpoczyna/kończy zapis wideo bieżącego
widoku i przechowuje nagranie jako <nazwa
urządzenia>_rrrrMMddggmmsstttt.vxx w
lokalizacji C:\BOSCH\Access Professional
Edition\PE\Data\Video (ścieżka domyślna).

(= Punkt zainteresowania) Tworzy obraz
zatrzymany bieżącego widoku – przed nazwą
pliku dodane są litery POI_.
Jako znacznik tworzony jest też komunikat
dziennika.

Konfiguracja widoków wyświetlacza
Określony wybór i uszeregowanie kamer można zapisać, a następnie przywołać według nazwy
w późniejszym czasie. Powoduje to oszczędność czasu, ponieważ w przeciwnym razie
konieczny byłby wybór i ręczna konfiguracja tego samego widoku.
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Najpierw należy ręcznie skonfigurować żądany widok poprzez umieszczenie kamer w
odpowiadających im oknach w sposób wybrany przez użytkownika.
Następnie widokowi należy przypisać treściwą nazwę, edytując dolną listę wyboru, i zachować,
naciskając klawisz ENTER. Widoki można później wywoływać według nazwy z danej listy
wyboru.
W ten sposób operatorzy mogą zapisywać różne widoki kamer przeznaczone do różnych
celów, np. do monitorowania personelu przybywającego rano do budynku i opuszczającego go
wieczorami. Zapisane widoki są przypisywane do stacji roboczej, nie zaś do określonego
operatora. Nie można ich edytować. Aby zmienić widok, należy najpierw wywołać go z listy
wyboru, a następnie usunąć nazwę za pomocą przycisku

 po prawej stronie listy wyboru, zmodyfikować położenie kamery zgodnie z wymaganiami i
zapisać pod tą samą nazwą co przed użyciem klawisza ENTER.
Zapisane widoki są przypisywane do stacji roboczej, a nie do operatora, dzięki czemu
operatorzy mogą korzystać z widoków skonfigurowanych przez ich współpracowników.

3.5.2 Obraz na żywo
Oprócz funkcji sterowania drzwiami, menu podręczne pokazujące wejścia i czytniki na liście
stanów urządzeń zawiera także pozycje służące do dołączania obrazu na żywo.

Uwaga!
Funkcje te nie są dostępne na liście stanów urządzeń w aplikacji Logviewer (Analiza
dziennika).

Istnieje jedna ogólna pozycja dla każdej skonfigurowanej kamery przypisanej do danego
wejścia. Jeśli skonfigurowana zostanie maksymalna liczba kamer, menu podręczne trybu
obrazu na żywo pojawia się w następującej postaci:
– Kamera identyfikacyjna
– Back camera 1 (Kamera tylna 1)
– Back camera 2 (Kamera tylna 2)
– Front camera 1 (Kamera przednia 1)
– Front camera 2 (Kamera przednia 2)

Po wybraniu kamery na wyświetlaczu transmitowany jest obraz na żywo. Jeśli zestaw danych
osobowych nie został wybrany, obraz na żywo jest wyświetlany w polu dialogowym (zamiast
czasu); w przeciwnym wypadku pojawia się w mniejszym formacie, po prawej stronie listy
stanów urządzeń.

Jeśli zestaw danych osobowych został wybrany do edycji, podczas gdy wyświetlany jest duży
obraz na żywo, tryb obrazu na żywo przełącza się do mniejszego formatu.
Jeśli funkcja nadawania obrazu na żywo jest aktywna, menu podręczne zawiera pozycję Video
off (Wył. wideo), której wybranie powoduje przywrócenie stanu domyślnego.
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Uwaga!
Tryb obrazu na żywo można też uaktywnić za pośrednictwem listy kamer na karcie Video
devices (Urządzenia wizyjne) poprzez wybranie odpowiedniej pozycji na liście.
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4 Personnel data (Dane osobowe)
Aby wprowadzić nową osobę, należy otworzyć odpowiednie okno dialogowe za pomocą

przycisku  lub za pośrednictwem menu Persons > New person (Osoby > Nowa osoba).

Uwaga!
W ten sposób tworzone są nowe zestawy danych osobowych. Aby zmienić istniejący zestaw

danych, kliknij dwukrotnie wpis na liście osób lub wybierz osobę i kliknij przycisk  na
pasku narzędzi. Zostanie otwarte to samo okno dialogowe, ale będzie zawierać dane wybranej
osoby.
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4.1 Personnel and card data (Dane osobowe i karty
identyfikacyjnej)
 Okno dialogowe Personal data (Dane osobowe) i uprawnienia zawiera wszystkie istotne dane
osoby i jej karty identyfikacyjnej, jak również informacje specjalne umieszczone na karcie.
Minimalny zakres informacji, który należy wprowadzić, aby zapisanie danych było możliwe, to
imię i nazwisko oraz grupa personelu.
Można wprowadzić następujące informacje:

Pole danych/
Pole wejściowe

Opis

Osoba

Title (Tytuł) Dane te wyświetlane są w widoku danych
osobowych w kolejności: tytuł, imię,
nazwisko. Lista osób nie zawiera tytułu.

Last name
(Nazwisko)

First name
(Imię)

Date of birth
(Data
urodzenia)

Datę w formie liczb należy wprowadzić za
pomocą klawiatury lub wybrać za pomocą
przycisków przewijania (małe strzałki w
górę/w dół).

Company
(Firma)

Nazwę firmy lub działu można wprowadzić
w czterech wierszach. Zawijanie wierszy
można uzyskać klawiszami Ctrl + ENTER.
Maksymalnie 114 znaków.

Telefon Wyświetlany również jako informacja o
osiągalności danej osoby. Maksymalnie 30
znaków.

Valid from ...
to ... (Ważne
od ... do ...)

Tutaj można wprowadzić termin ważności
kontroli dostępu. Puste pola oznaczają
nieograniczoną ważność.

Personnel
group (Grupa
personelu)

Wymagane wprowadzenie danych. Musi
zostać wybrana jedna grupa personelu.

Dane karty identyfikacyjnej

(Wyświetlanie
stanu karty)

Wskazuje w formie symbolu aktualny stan
karty.

 Nie przydzielono karty

 Karta przydzielona

Numer
personalny

Należy wprowadzić numer personalny,
maksymalnie 6 cyfr.
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Pole danych/
Pole wejściowe

Opis

1. Card-No.
(Numer karty)

Należy wprowadzić numer karty,
maksymalnie 6 cyfr
Wszystkie karty oferują te same
uprawnienia dostępu.

2. Numer karty

3. Numer karty

Funkcja specjalna

Uprawnienie do
długotrwałego
otwarcia drzwi
(tryb biuro)

Nadaj uprawnienia do używania trybu biura
na odpowiednio skonfigurowanych drzwiach
(zob. w instrukcji konfiguracji).

Aktywuj funkcję
kontroli 1

Funkcją kontroli 1 zostanie wywołana przez
odpowiednio skonfigurowany czytnik.

Aktywuj funkcję
kontroli 2

Funkcją kontroli 2 zostanie wywołana przez
odpowiednio skonfigurowany czytnik.

Komunikaty specjalne na czytniku

Nazwa
wyświetlana

Wyświetlany tekst dla czytnika z
wyświetlaczem. Domyślnie: imię, nazwisko.
Maksymalnie 20 znaków.

Tekst na
wejście

W tym miejscu można wprowadzić
indywidualne teksty powitalne/pożegnalne
dla czytników używanych do zapisu
czasowego. W tym celu należy w aplikacji
Configurator należy aktywować parametr
systemowy Show welcome/leaving
message (Wyświetl tekst powitalny/
pożegnalny). Maksymalnie 20 znaków.

Text on
departure
(Tekst na
wyjście)

Dane kontroli dostępu

Time model
(Model
czasowy)

Umożliwia wybór istniejącego modelu
czasowego. Dana osoba ma uprawnienia
dostępu tylko w wybranych przedziałach
czasu.

PIN (Kod PIN) Wprowadzanie kodów PIN jest możliwe
tylko w przypadku czytników z klawiaturą.
Kod PIN nie może być ciągiem kolejnych
cyfr (np. 1234) ani palindromem (np. 0110).
Ustawienia ogólne kodów PIN można
określić w oknie dialogowym Configurator >
Settings (Konfigurator > Ustawienia).
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Pole danych/
Pole wejściowe

Opis

Verification +
Confirmation
PIN
(Weryfikacja +
kod PIN
potwierdzenia)

Ten kod PIN może zostać wygenerowany
– automatycznie przez system, względnie
– wprowadzony ręcznie jako kod PIN o

długości 4–8 cyfr (domyślnie = 4),
który będzie stanowić dodatkowe
zabezpieczenie po okazaniu karty przy
wejściu.

Identification-
PIN/ ID-PIN
(Kod
identyfikacyjny
PIN/PIN ID)

Ten kod PIN musi być unikatowy w całym
systemie. Może zostać wygenerowany
– automatycznie przez system, względnie
– wprowadzony ręcznie jako kod PIN o

długości 4–8 cyfr (domyślnie = 4),
który będzie stanowić dodatkowe
zabezpieczenie po okazaniu karty przy
wejściu.

Kod identyfikacyjny PIN jest przed
zapisaniem wyświetlany w oknie
dialogowym komunikatów.

Zamiast okazywać kartę można wpisać kod
identyfikacyjny PIN na klawiaturze czytnika.
Ponieważ kod PIN funkcjonuje praktycznie
jako numer karty identyfikacyjnej,
przypisane są do niego wszystkie
uprawnienia, jakie zostały przypisane temu
numerowi karty.

Arming-PIN/
IDS-PIN (Kod
PIN uzbrojenia/
Kod PIN
systemu
sygnalizacji
włamania)

Wprowadź kod PIN o długości 4–8 cyfr
(domyślnie = 4, taka sama długość, jak w
przypadku kodu weryfikacyjnego PIN) w
celu uzbrojenia systemu alarmowego.
Pole wyboru separate IDS-PIN (oddzielny
kod PIN systemu sygnalizacji włamania)
(Configurator > Settings (Konfigurator >
Ustawienia)) określa, czy te pola są
wyświetlane.
Domyślnie pola funkcji uzbrojenia/
rozbrojenia systemu sygnalizacji włamania
nie są wyświetlane.
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Pole danych/
Pole wejściowe

Opis

Jeśli nie ustawiono oddzielnego kodu
uzbrojenia PIN, wówczas do uzbrojenia
systemu sygnalizacji włamania można użyć
kodu weryfikacyjnego PIN. Jeśli jednak
ustawiono oddzielny kod uzbrojenia PIN,
należy z niego korzystać — kod weryfikacyjny
PIN nie będzie działał jako kod uzbrojenia.

Uwaga: Czwarty rodzaj kodu PIN, Door-PIN (Kod PIN do
drzwi), można przypisać oddzielnie do każdych drzwi. Każdy
użytkownik danych drzwi musi znać ten kod.
Kod PIN do drzwi można ustawić i aktywować w
konfiguratorze na stronie Entrances (Wejścia) pod funkcją
PIN or Card (Kod PIN lub karta).

Ważne: W przypadku używania kontrolerów i czytników
Wiegand, aby użyć kodu PIN identyfikacyjnego, uzbrojenia lub
do drzwi, należy aktywować definicję karty Wiegand PIN or
Card (Kod PIN lub karta) (Nr 6).

Przyciski po prawej stronie okna dialogowego

Take picture
(Zrób zdjęcie)

Te przyciski są dostępne pod warunkiem, że
aplikacja Card Personalization (CP)
(Personalizacja kart) (Tworzenie kart, Strona
45) jest zainstalowana na tej stacji
roboczej i została uruchomiona.

Preview card
(Wyświetl
podgląd karty)

Print card
(Drukuj kartę)

Print card
reverse side
(Drukuj drugą
stronę karty)

Acknowledgem
ent
(Potwierdzenie
)

Import picture
(Importuj
zdjęcie)

Funkcja ta umożliwia import zdjęć
zapisanych w formacie .jpg lub .bmp.
Zdjęcie będzie wyświetlane w oknie danych
osobowych.

Delete picture
(Usuń zdjęcie)

Aktywny tylko wtedy, gdy zdjęcie zostało
zaimportowane.
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Pole danych/
Pole wejściowe

Opis

Delete card 1
(Usuń kartę 1)

Aktywny tylko wtedy, gdy przydzielono
kartę. Zmienia wskazania stanu karty (patrz
wyżej).

Delete card 2
(Usuń kartę 2)

Delete card 3
(Usuń kartę 3)

Assign card 1
(Przydziel kartę
1)

Przydziela danej osobie numer karty i
odpowiednio zmienia wskazanie stanu karty
(patrz wyżej).

Assign card 2
(Przydziel kartę
2)

Assign card 3
(Przydziel kartę
3)

Uwaga!
Kody PIN identyfikacyjny i do drzwi nie mogą być używane w przypadku modeli drzwi z
funkcją uzbrojenia systemu bezpieczeństwa (TM 10 i 14).

4.2 Przydzielanie i odbieranie kart identyfikacyjnych
Każdy posiadacz karty identyfikacyjnej może mieć maksymalnie trzy karty, które można
przydzielać i odbierać niezależnie. W zależności od konfiguracji systemu dane karty można
zapisywać ręcznie lub za pomocą czytnika rejestrującego, ale w danym czasie można
wykorzystać tylko jedną z tych metod: po skonfigurowaniu czytnika rejestrującego (Tools >
Properties (Narzędzia > Właściwości)) nie można równolegle stosować metod ręcznych.
Ręczny zapis danych jest uzasadniony w przypadku stosowania różnych technologii kart, gdyż
umożliwia operatorowi przechodzenie pomiędzy różnymi formatami bitowymi kart. Natomiast
w przypadku zastosowania czytnika rejestrującego możliwe jest użycie jedynie kart
wykorzystujących te same technologie.

Uwaga!
W systemie Access PE posiadacz karty identyfikacyjnej może używać różnego rodzaju
poświadczeń w wielu formatach i technologiach. Służą one jednak do identyfikacji tej samej
osoby za pomocą tego samego zestawu uprawnień, blokad, kodów PIN, modeli czasowych i
ograniczeń obszarowych.

W zależności od ustawień Properties (Właściwości) (Zmiana konfiguracji czytników rejestracji,
Strona 14) dane z karty można wprowadzać ręcznie lub za pomocą czytnika. W danym
momencie aktywny może być tylko jeden z trybów wprowadzania danych. Skonfigurowane
czytnika powoduje, że ręczne wprowadzanie danych przestaje być możliwe.
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Ręczne wprowadzanie danych
W przypadku ręcznego wprowadzania danych oprócz niezbędnych danych osobowych
(nazwisko i grupa personelu) należy też podać numer karty (domyślnie 6-cyfrowy). Please
enter a valid card-no. for the person! (Wprowadź prawidłowy numer karty dla tej osoby!)
Po zatwierdzeniu przyciskiem Assign card (Przydziel kartę) następuje weryfikacja unikalności
nadanego numeru. This card is already assigned to the following person: xxx (Ta karta jest
już przypisana do osoby: xxx)
Numer karty jest następnie kodowany w oparciu o domyślne dane karty identyfikacyjnej
pokazane w oknie dialogowym Settings (Ustawienia) aplikacji Access PE Configurator. O
pomyślnym przydzieleniu karty informuje odpowiedni komunikat, który przed zapisaniem
danych należy potwierdzić przyciskiem OK.

Jeśli w oknie Personnel Management properties (Właściwości zarządzania personelem)
(Zmiana konfiguracji czytników rejestracji, Strona 14) jest aktywna opcja Connect to LAC
Service (Połączenie z usługą LAC), zmiany danych osobowych są bezzwłocznie przesyłane do
usługi LAC i obowiązują w całym systemie.

Uwaga!
Oprócz numeru karty danej osobie należy przypisać uprawnienia (Authorizations
(Uprawnienia), Strona 40), aby umożliwić jej dostęp do wszystkich wymaganych wejść.
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Jeśli w oknie Personnel Management properties (Właściwości zarządzania personelem) opcja
Do not show dialog for editing card information (Nie pokazuj okna dialogowego do edycji
informacji o karcie) nie jest zaznaczona, wówczas naciśnięcie przycisku Assign card (Przydziel
kartę identyfikacyjną) powoduje wyświetlenie poniższego okna dialogowego umożliwiającego
zmianę ustawień domyślnych (zob. Access PE — Konfigurator).

Wprowadzanie danych za pomocą czytnika
Podłączony czytnik, który umożliwi wprowadzanie danych karty, musi zostać skonfigurowany
w oknie Personnel Management Properties (Właściwości zarządzania personelem). Ręczne
wprowadzanie danych zostanie wówczas automatycznie wyłączone.
W tym przypadku wszystkie dane są wczytywane bezpośrednio z karty. Wprowadzanie danych
z klawiatury nie jest wtedy konieczne i będzie ignorowane przez system.
Użytkownik zostanie wezwany do przytrzymania karty identyfikacyjnej przed czytnikiem i
otrzyma zezwolenie na wejście lub komunikat o niepowodzeniu.

4.3 Authorizations (Uprawnienia)
Ta strona jest widoczna tylko wtedy, gdy aktualnie zalogowany użytkownik ma uprawnienia
administratora (Uprawnienia użytkownika) do modyfikacji uprawnień użytkownika.
Ta karta służy w systemie kontroli dostępu do przypisywania uprawnień osobom. Jeśli do
przydzielenia domyślnych uprawnień grupom personelu użyto aplikacji Configurator
(Konfigurator) (okno dialogowe Authorization groups (Grupy uprawnień dostępu)), wówczas
dana osoba otrzyma te uprawnienia wraz z przypisaniem do danej grupy personelu.

Za pomocą tej karty można jednak uzupełnić uprawnienia dostępu użytkownika.
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Okno dialogowe zawiera cztery pola list. W polach po prawej stronie wyświetlane są wszystkie
skonfigurowane grupy uprawnień (górna lista) i wszystkie skonfigurowane pojedyncze wejścia
(dolna lista). Łączne uprawnienia dostępu danej osoby obejmują wszystkie wymienione w tym
oknie dialogowym przypisane grupy uprawnień i uprawnienia indywidualne.
Uprawnienia (grupy lub wejścia) mogą zostać przekazane osobie albo dwukrotnym kliknięciem
jednego z okien list z prawej strony, albo przez wybranie jednej z list i kliknięcie przycisku

. Przycisk  przekazuje jednorazowo wszystkie dostępne uprawnienia. Przydzielać
można dowolne kombinacje uprawnień grupowych i indywidualnych. Przypisane uprawnienia

można odebrać dwukrotnym kliknięciem lub za pomocą przycisków  i .
Jeśli grupy uprawnień mają modele czasowe (powinny być odpowiednio nazwane), wejścia
przypisane danej grupie są dostępne tylko w czasie zdefiniowanym w modelu czasowym danej
osoby. Należy zwrócić uwagę na przypadki specjalne opisane w temacie Zastosowanie modeli
czasowych *** w systemie Access PE.
Domyślnie uprawnienia w momencie przydziału mają nieograniczony termin obowiązywania,
jednak można ograniczyć zarówno uprawnienia grupowe, jak i indywidualne, wpisując daty w
kolumnach valid from (ważne od) i valid to (ważne do). Kliknięcie komórki w tych kolumnach

powoduje otwarcie edytora wprowadzania dat i godzin: 
Daty można wprowadzać za pomocą klawiatury lub myszy, korzystając z małych strzałek
przewijania znajdujących się z prawej strony okna edytora. Klawiszem spacji można
przechodzić między polami dni, miesięcy, lat itp. Kolejna możliwość wyboru danych pojawia
się po kliknięciu otwartego pola daty prawym klawiszem myszy. Wyświetlony zostaje kalendarz
pozwalający na szybki wybór daty.
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W ten sposób w momencie wprowadzania do systemu nowej osoby można przydzielić jej
uprawnienia, które zaczną obowiązywać dopiero w przyszłości. Nie jest konieczne
administracyjne odbieranie uprawnień, gdyż można ustawić automatyczne wygaśnięcie
uprawnień w danym dniu. Jeśli data valid from (ważne od) jest późniejsza niż data valid to
(ważne do), wówczas uprawnienia zostaną odebrane po nadejściu daty valid to (ważne do) i
wznowione po nadejściu daty valid from (ważne od). Takie rozwiązanie może być użyteczne,
gdy pracownik przebywa na urlopie.
Dopiero po naciśnięciu przycisku OK wprowadzone dane zostaną zapisane w danych
osobowych lub w uprawnieniach. Wszystkie zmiany danych automatycznie zostaną wysłane do
kontrolerów, jeśli w ustawieniach Tools > Properties (Narzędzia > Własności) została
aktywowana opcja Connect to LAC Service (Połączenie z usługą LAC). W sytuacjach
wyjątkowych można wysłać dane bezpośrednio, korzystając z menu Persons > Transmit
selected person to LAC service (Osoby > Prześlij wybraną osobę do usługi LAC) lub Persons
> Transmit all persons to LAC service (Osoby > Prześlij wszystkie osoby do usługi LAC).

4.4 Dodatkowe pola
Ta karta jest widoczna tylko wtedy, gdy w aplikacji Access PE Configurator wprowadzono
parametry przynajmniej do jednego z dziesięciu dodatkowych pól.
Można utworzyć do dziesięciu dodatkowych pól. Ich liczba oraz nazwy mogą być zmienne. W
każdym polu można wpisać do 40 znaków.
Pola są wyświetlane w odpowiedniej kolejności. Jeśli jedno z pól zostanie pominięte, w jego
miejscu wprowadzana jest spacja jako symbol zastępczy. Późniejsze skonfigurowanie pola
powoduje zastąpienie symbolu zastępczego w odpowiedniej pozycji.
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!

Przestroga!
Każde pole wprowadzania danych jest przyporządkowane do określonego pola bazy danych,
więc dane mogą być przechowywane, wybierane i uwzględniane w raportach. Oznacza to
jednak, że zmiany używanych pól dodatkowych prowadzą do utraty danych w bazie danych.
Jeśli przeznaczenie pól nie ulegnie zmianie, wówczas w każdej chwili można zmienić nazwy
pól.

4.5 Zastosowanie modeli czasowych
Modele czasowe, które są skojarzone z danymi osobowymi, są aktywne tylko w przypadku, gdy
nie zostały zmienione ustawienia domyślne czytnika i nie jest zaznaczona opcja No time model
check (Nie sprawdzaj modelu czasowego).
Z uwagi na wielostronność zastosowania modeli czasowych i zagrożenie powielaniem
przypisań zaleca się przestrzeganie następujących reguł rozwiązywania konfliktów:
Jeśli osobie udzielono dostępu do określonych wejść na podstawie modelu czasowego i jeśli
tej samej osobie udzielono dostępu do tych samych wejść bez modelu czasowego, wówczas
obowiązują luźniejsze ograniczenia. To znaczy, że w tym przypadku model czasowy nie będzie
stosowany.
Przykład:
Osoba otrzymuje następujące uprawnienia:
– dostęp do wejść A, B, C i D w ramach modelu czasowego od 09:00 do 17:00 każdego

dnia;
– indywidualne prawa dostępu do wejść B i D bez modelu czasowego.
Osoba ta ma obecnie dostęp do wejść A i C od 09:00 do 17:00 codziennie i nieograniczony
dostęp do wejść B i D.
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– Jeśli osobie przydzielono różne uprawnienia dostępu obejmujące te same wejścia, ale
zarządzane różnymi modelami czasowymi, wówczas obowiązuje połączenie modeli
czasowych.

Przykład:
Osoba otrzymuje następujące uprawnienia:
– dostęp do wejść A, B, C i D w ramach modelu czasowego od 07:00 do 13:00 każdego

dnia;
– dostęp do wejść B, D, E i F w ramach modelu czasowego od 09:00 do 17:00 każdego

dnia.
Osoba ta ma obecnie dostęp do wejść A i C od 07:00 do 13:00, wejść B i D od 07:00 do 17:00
oraz wejść E i F od 09:00 do 17:00.
– Jeśli danej osobie przydzielone zostaną grupy uprawnień dostępu z modelami czasowymi,

a osoba ta dodatkowo otrzyma model czasowy do używania swojej karty identyfikacyjnej,
wówczas obowiązuje część wspólna zdefiniowanych przedziałów czasu.

Przykład:
Osoba otrzymuje następujące uprawnienia:
– grupa uprawnień dostępu do wejść A, B, C i D i model czasowy od 07:00 do 13:00

każdego dnia;
– grupa uprawnień dostępu do wejść B, D, E i F i model czasowy od 09:00 do 17:00

każdego dnia;
– oraz dodatkowo model pracy z przedziałem czasu od 11:00 do 19:00 każdego dnia.
Osoba ta ma obecnie dostęp do wejść A i C od 11:00 do 13:00 oraz wejść B, D, E i F od 11:00
do 17:00.



Access Professional Edition Tworzenie kart | pl 45

Bosch Security Systems B.V. Instrukcja konfiguracji 2019-07 | |

5 Tworzenie kart
System Access PE jest wyposażony w zintegrowany program do personalizacji kart. To
oprogramowanie można zainstalować na dowolnie wybranych komputerach. Do personalizacji
kart niezbędny jest także odpowiedni sprzęt (aparat fotograficzny i drukarka), dlatego zaleca
się zainstalowanie tych składników na komputerach, które będą wykorzystywane do
personalizacji kart.
Należy pamiętać, że nawet funkcja importowania obrazów, na przykład do wyświetlania
obrazów w oknie dialogowym danych osobowych, działa jedynie na komputerach, na których
zainstalowano i uruchomiono program do personalizacji kart.

5.1 Tworzenie kart
Z funkcji tworzenia kart można korzystać na stacjach roboczych, na których działa program
Badge Designer (Projektant identyfikatorów). Odpowiednie przyciski do tego celu znajdują się
na karcie Personnel data (Dane osobowe).

Dodatkowo do stacji roboczych musi być podłączone niezbędne wyposażenie: aparat i
drukarka do kart.
W celu skonfigurowania sprzętu należy uruchomić konfigurator personalizacji kart.
Kamerę lub drukarkę należy skonfigurować, wybierając wejścia odpowiednio na karcie Video
(Wideo) lub Print (Drukowanie). Dodatkowe informacje znajdują się w pliku pomocy tego
narzędzia.
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W celu utworzenia karty identyfikacyjnej zalecane jest wykonanie następujących czynności:
– Import or take a photo (Importuj lub zrób zdjęcie)
– Preview card (Podgląd karty identyfikacyjnej), (opcjonalnie)
– Print card/reverse side (Drukuj kartę/drugą stronę karty)
– card receipt (Wydrukowanie potwierdzenia otrzymania karty), (opcjonalnie)

5.2 Wykonywanie lub importowanie zdjęć
Zdjęcia osób, które mają zostać wydrukowane na karcie identyfikacyjnej lub wyświetlone w
oknie dialogowym danych osobowych, można wykonać za pomocą podłączonego aparatu lub
zaimportować, jeśli istnieją w postaci pliku.

Importowanie zdjęć
Zdjęcia pracowników można importować w formie plików i przypisywać do danych
osobowych.
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Uwaga!
Funkcja importu zdjęć jest dostępna również na stacjach roboczych, na których nie
zainstalowano aplikacji Card Personalization (Personalizacja kart). Jednak w tym przypadku
zdjęcia mogą być importowane tylko w oryginalnym rozmiarze. Niedostępne są również
opisane tutaj funkcje edycji.

Aby zaimportować zdjęcie z pliku, należy kliknąć przycisk Import picture (Importuj zdjęcie) i
wybrać plik w oknie dialogowym wyboru pliku. W ustawieniach konfiguracji programu Card
Personalization (Personalizacja kart) dostępny jest m.in. standardowy katalog do importu
plików — jest on otwierany w momencie uruchomienia funkcji importu. Jednak za pomocą okna
dialogowego wyboru pliku można znaleźć i wybrać dowolny plik ze zdjęciem znajdujący się w
systemie.
Zaznaczony plik jest wyświetlany w oknie podglądu, co pomaga w wyborze właściwego
zdjęcia.

Po wybraniu zdjęcie zostaje wyświetlone w oknie dialogowym edycji, w którym można przyciąć
zdjęcie i zmienić jego rozmiar. Czerwona ramka oznacza tę część fotografii, która zostanie
zapisana w systemie jako zdjęcie danej osoby.
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Położenie wybranej w ramce części zdjęcia można zmienić, przeciągając i upuszczając ją za
pomocą lewego przycisku myszy.

Wybraną część zdjęcia można również powiększyć, klikając ją lewym przyciskiem myszy,
przytrzymując i rozciągając. W ten sposób nawet niewielkie fragmenty zdjęcia umieścić na
kartach, pod warunkiem, że rozdzielczość zdjęcia pozwoli na powiększenie.
Kliknięcie przycisku OK powoduje zaimportowanie wybranego fragmentu.
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Rozmiar ramki jest dopasowywany do rozmiaru ramki w oknie dialogowym i/lub do rozmiaru
zdjęcia zdefiniowanego w układzie karty i bezpośrednio po zatwierdzeniu importu wyświetlany
jest podgląd zdjęcia.

Wykonywanie zdjęcia
Aplikację do tworzenia kart, Card Personalization (Personalizacja kart) (CP), należy
dostosować do typu aparatu podłączonego do stacji roboczej. Do tego celu służy okno
dialogowe CP Configuration (Konfiguracja aplikacji CP). Dodatkowe informacje o możliwych
ustawieniach znajdują się w pomocy do aplikacji.
Poniższe zrzuty ekranu powstały z użyciem programu Video for Windows i mogą wyglądać
inaczej w zależności od typu aparatu.
Kliknięcie przycisku Take picture (Zrób zdjęcie) powoduje wyświetlenie następującego okna
dialogowego:

W razie potrzeby za pomocą przycisku  można sprawdzić i zmienić ustawienia aparatu.
Jeśli ustawienia są zgodne z wymaganiami, naciśnięcie przycisku Freeze (Zamroź) spowoduje
unieruchomienie zdjęcia.
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Tryb Live image (Obraz na żywo) można w każdej chwili aktywować ponownie, jeśli
zatrzymane (unieruchomione) zdjęcie nie odpowiada wymaganiom. Jeśli zdjęcie ma zostać
wykorzystane podczas wystawiania karty, a także w oknie danych osobowych, należy nacisnąć
przycisk Apply (Zastosuj).
Otwarte zostanie kolejne okno dialogowe, Crop picture (Przycinanie zdjęcia). Za pomocą
ramki przycinania można wybrać fragment zdjęcia, który ma pojawić się na karcie.
Szczegóły dotyczące korzystania z ramki przycinania można znaleźć w części Importowanie
zdjęć.

5.3 Przeglądanie i drukowanie kart identyfikacyjnych
 Przyciski Preview card (Podgląd karty) i Print card reverse side (Drukuj drugą stronę karty) są
aktywne tylko wtedy, gdy układ karty został przypisany do odpowiedniej grupy personelu w
aplikacji Access PE Configurator (okno dialogowe: Personnel Groups (Grupy personelu)).

Preview card (Wyświetl podgląd karty)
Po wykonaniu zdjęcie zostaje automatycznie umieszczone w miejscu przeznaczenia na karcie,
gdzie przed wydrukiem można obejrzeć je w podglądzie. Podgląd karty można wyświetlić w
poniższym oknie dialogowym, które otwiera przycisk Preview card (Podgląd karty).

Zamknij okno dialogowe, klikając przycisk OK.

Print card (Drukuj kartę)
Jeśli układ karty odpowiada wymaganiom, można przejść do etapu wydruku. Przycisk Print
card (Drukuj kartę) otwiera poniższe okno dialogowe, podobne do okna wyświetlania karty,
ale zawierające opcję wydruku.
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Naciśnięcie przycisku Print (Drukuj) rozpoczyna proces drukowania przez otwarcie okna
dialogowego wyboru drukarki. Jeśli w aplikacji Configurator (Konfigurator) zdefiniowano
drukarkę domyślną, drukowanie rozpoczyna się natychmiast.

Print card reverse side (Drukuj drugą stronę karty)
Jeśli ma zostać wydrukowana druga strona karty, w tym celu można zdefiniować specjalny
układ i zawartość.
Uwaga: przed drukowaniem drugiej strony karty należy się upewnić, że strona, która jest już
zadrukowana, znajduje się na wierzchu w podajniku drukarki do kart.
Wskazówka: Zaleca się, aby nie drukować na drugiej stronie żadnych danych osobowych, lecz
tylko dane ogólne. W takim przypadku można wydrukować drugą stronę dla wielu kart,
zapewniając w ten sposób zapas. Umożliwi to szybsze przygotowanie kart, kiedy zajdzie taka
potrzeba.
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5.4 Drukowanie potwierdzeń odebrania karty identyfikacyjnej
 Kolejną funkcją aplikacji do tworzenia kart identyfikacyjnych jest możliwość wydruku
potwierdzenia odebrania karty. Dzięki potwierdzeniu dział wydający karty i odbiorca karty
otrzymują informacje dotyczące zapisanych na niej danych.
Aby korzystać z tej funkcji, konieczne jest utworzenie i zapisanie szablonu dla grupy personelu
w oknie dialogowym Grupy personelu aplikacji Access PE Configurator.
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6 Raporty
Aby zestawić zawartość bazy danych w określony sposób, uporządkować ją i przygotować do
wydruku, można użyć funkcji listy systemu Access PE.
W celu odfiltrowania wyników w taki sposób, aby widoczne były tylko dane, które użytkownik
chce widzieć, można użyć gotowych układów, które zapewniają dostępność określonych
informacji dotyczących kontroli dostępu (na przykład, kto ma jakie uprawnienia do
poszczególnych drzwi).

6.1 Raporty

Za pomocą przycisku  można zmienić widok danych osobowych na widok okna
dialogowego, w którym można tworzyć i wyświetlać raporty dotyczące kontroli dostępu.

Dostępnych jest kilka układów raportu i filtrów zawartości:
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Układ Dostępne filtry Opis

Personnel
data (Dane
osobowe)

Last name
(Nazwisko)
First name (Imię)
Personnel no.
(Numer
personalny)
Card no. (Numer
karty)
Card no. from ...
to (Numer karty
od... do)
Dept./Company
(Dział/Firma)
Personnel Group
(Grupa personelu)

Wyświetla dane osobowe.
Dane mogą być filtrowane
zgodnie z dowolnym lub
wszystkimi dostępnymi
filtrami. Zastosowanie wielu
filtrów ogranicza ilość
danych (logiczne I).
Można np. wyszukać
wszystkie osoby, których
nazwisko rozpoczyna się na
literę A i których numer
karty mieści się w zakresie
od 900 do 999.
Znak * można zastosować
jako symbol wieloznaczny,
zastępujący dowolny znak
lub brak znaków.

Blocked
Persons
(Osoby
zablokowa
ne)

Last name
(Nazwisko)
First name (Imię)
Personnel no.
(Numer
personalny)
Card no. (Numer
karty)
Card no. from ...
to (Numer karty
od... do)
Dept./Company
(Dział/Firma)
Personnel Group
(Grupa personelu)

Wyświetla na głównym
ekranie danych osobowych
osoby, których stan karty
jest inny niż valid (ważna)
(np. zablokowana, 3 x
błędny PIN, wybrana do
kontroli losowej).
Dane mogą być filtrowane
zgodnie z dowolnym lub
wszystkimi dostępnymi
filtrami. Zastosowanie wielu
filtrów ogranicza ilość
danych (logiczne I).
Można np. wyszukać
wszystkie osoby, których
nazwisko rozpoczyna się na
literę A i których numer
karty mieści się w zakresie
od 900 do 999.
Znak * można zastosować
jako symbol wieloznaczny,
zastępujący dowolny znak
lub brak znaków.

Persons —
Authorizati
ons (Osoby
—
uprawnieni
a)

Last name
(Nazwisko)
First name (Imię)
Personnel no.
(Numer
personalny)

Wykaz osób z przypisanymi
im uprawnieniami. Grupy
uprawnień mają oznaczenie
(G), natomiast uprawnienia
indywidualne — oznaczenie
(E). Wyświetlane są również
daty ważności.
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Układ Dostępne filtry Opis

Card no. (Numer
karty)
Card no. from ...
to (Numer karty
od... do)
Dept./Company
(Dział/Firma)
Personnel Group
(Grupa personelu)
Authorizations
(Uprawnienia)

Filtrowanie może być
oparte na jednym lub wielu
uprawnieniach. Do wybrania
dowolnego uprawnienia lub
anulowania jego wyboru
wystarczy jedno kliknięcie.

Persons —
Areas
(Osoby —
obszary)

Last name
(Nazwisko)
First name (Imię)
Personnel no.
(Numer
personalny)
Card no. (Numer
karty)
Card no. from ...
to (Numer karty
od... do)
Dept./Company
(Dział/Firma)
Personnel Group
(Grupa personelu)
Locations
(Lokalizacje)

Na podstawie obszarów
skonfigurowanych w
systemie wyświetlane są
zarówno nazwiska jak i
liczba osób znajdujących się
w danym obszarze.
Filtrowanie może być
oparte na jednym lub wielu
obszarach. Do wybrania
dowolnego obszaru lub
anulowania jego wyboru
wystarczy jedno kliknięcie.

Authorizati
ons —
Persons
(Uprawnien
ia — osoby)

Authorizations
(Uprawnienia)

Wykaz uprawnień wraz z
posiadającymi je osobami.
Grupy uprawnień mają
oznaczenie (G), natomiast
uprawnienia indywidualne —
oznaczenie (E).
Wyświetlane są również
daty ważności.
Filtrowanie może być
oparte na jednym lub wielu
uprawnieniach. Do wybrania
dowolnego uprawnienia lub
anulowania jego wyboru
wystarczy jedno kliknięcie.

Devices
(Urządzeni
a)

Device type (Typ
urządzenia)
Device description
(Opis urządzenia)

Lista typów urządzeń
(kontrolery, wejścia,
czytniki).
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Układ Dostępne filtry Opis

Filtrowanie może być
oparte na jednym lub wielu
typach urządzeń. Do
wybrania dowolnego typu
urządzenia lub anulowania
jego wyboru wystarczy
jedno kliknięcie.
Urządzenia można również
filtrować według ich opisu.
Np. wszystkie urządzenia,
których opis zaczyna się na
literę A.
Znak * można zastosować w
opisie urządzenia jako
symbol wieloznaczny,
zastępujący dowolny znak
lub brak znaków.

Users
(Użytkowni
cy)

Last name
(Nazwisko)
First name (Imię)
Personnel no.
(Numer
personalny)
Card no. (Numer
karty)
Card no. from ...
to (Numer karty
od... do)
Dept./Company
(Dział/Firma)
Personnel Group
(Grupa personelu)

Lista osób, które są
użytkownikami systemu, i
przypisane im uprawnienia
użytkownika
Dane mogą być filtrowane
zgodnie z dowolnym lub
wszystkimi dostępnymi
filtrami. Zastosowanie wielu
filtrów ogranicza ilość
danych (logiczne I).
Można np. wyszukać
wszystkie osoby, których
nazwisko rozpoczyna się na
literę A i których numer
karty mieści się w zakresie
od 900 do 999.
Znak * można zastosować
jako symbol wieloznaczny,
zastępujący dowolny znak
lub brak znaków.

Persons —
Doors
(Osoby —
drzwi)

Last name
(Nazwisko)
First name (Imię)
Personnel no.
(Numer
personalny)
Card no. (Numer
karty)

Wykaz osób z przypisanymi
im drzwiami. Grupy
uprawnień mają oznaczenie
(G), natomiast uprawnienia
indywidualne — oznaczenie
(E). Wyświetlane są również
daty ważności.
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Układ Dostępne filtry Opis

Card no. from ...
to (Numer karty
od... do)
Dept./Company
(Dział/Firma)
Personnel Group
(Grupa personelu)
Authorizations
(Uprawnienia)

Osoby można filtrować
według tekstu, np.
wszystkie osoby, których
nazwisko zaczyna się na
literę A.
Znak * można zastosować w
opisie urządzenia jako
symbol wieloznaczny,
zastępujący dowolny znak
lub brak znaków.

6.2 Raporty: widok strony
Istnieje możliwość ustawiania filtrów ograniczających zawartość raportu. W przypadku braku
filtru raportowane są wszystkie dane. Przycisk Search (Wyszukaj) umożliwia wyszukanie
danych i ich wyświetlenie w oknie podglądu.

Uwaga!
Przed zmianą kryteriów filtrowania należy w pierwszej kolejności usunąć stare ustawienia za
pomocą przycisku Clear form (Wyczyść formularz), zapobiegając w ten sposób uzyskaniu
błędnych wyników.

Otwarte pliki dziennika można zapisać lub wydrukować. Element menu File > Print (Plik >

Drukuj) lub przycisk  otwiera podgląd.

Uwaga!
Wszystkie otwarte pliki dziennika zostaną wydrukowane.
Należy zamknąć wszystkie pliki, które nie mają być drukowane, lub ograniczyć wybór do
ważnych komunikatów.

Widok strony raportów zawiera szereg narzędzi do modyfikacji wyświetlanej zawartości i
sposobu jej wyświetlania:
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Przycisk Znaczenie Opis

Eksportuj Listę można eksportować do pliku
w celu dalszego przetworzenia.
Dostępne są następujące formaty:
Acrobat Portable Document
Format (PDF)
Wartości oddzielone przecinkiem
(*.CSV)

Drukuj Drukuje raport za pośrednictwem
okna dialogowego wydruku, które
umożliwia ustawienie drukarki
domyślnej.

Wybierz
stronę

Przyciski strzałek umożliwiają
przechodzenie do kolejnej,
ewentualnie pierwszej lub
ostatniej strony raportu.
Wyświetlany jest również numer
strony bieżącej i łączna liczba
stron raportu.

Liczba
stron

Przedstawia stronę bieżącą i
liczbę wszystkich stron.

Powiększ Domyślna skala (100%) może
zostać zmieniona według
potrzeby.

Eksportowanie list
Naciśnięcie przycisku  powoduje otwarcie okna dialogowego umożliwiającego zdefiniowanie
kryteriów eksportu.

Pole listy wyboru o nazwie Format oferuje formaty wyjściowe .pdf (do przekazywania i
archiwizowania określonych wyników wyszukiwania) i .csv (do dalszego przetwarzania
danych).
W przypadku eksportowania danych do pliku csv można je do pewnego stopnia przetworzyć.
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Oprócz wprowadzenia ogranicznika (Delimiter) oraz trybu (Mode) eksportu, można także
wykluczyć lub wyizolować z eksportu fragmenty raportu i strony (Report and Page sections)
(nagłówki kolumn i szczegóły strony) oraz fragmenty grupy (Group sections) (wybrane dane).
Jedną z poniższych opcji można wybrać jako Destination (Miejsce przeznaczenia).
– Application (Aplikacja) — otwiera plik za pomocą odpowiedniej aplikacji. Ta aplikacja musi

być zainstalowana na komputerze. Pliki pdf są otwierane za pomocą programu Adobe
Acrobat Reader, a pliki csv — za pomocą programu MS Excel.

– Disk file (Plik dyskowy) (domyślnie) — otwiera okno dialogowe Eksploratora w celu
wybrania żądanego katalogu. Proponowana jest nazwa do zapisania pliku.

– Exchange folder (Folder programu Exchange) — plik można wysłać bezpośrednio do
odbiorcy w programie MS Outlook.

– Lotus Domino Mail — plik można wysłać bezpośrednio do odbiorcy w programie Lotus
Domino Mail.
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7 Zapisy lokalne
Rejestrowanie zatrzymanych obrazów i filmów
Sekwencje wideo wyświetlane za pośrednictwem okien dialogowych systemu kontroli dostępu
pochodzą z rejestratorów wizyjnych, do których podłączone są skonfigurowane kamery
nadzorujące. W zależności od pojemności pamięci urządzenia, najstarsze zapisy będą
usuwane, a nowsze nadpisywane (bufor cykliczny).
W celu zabezpieczenia pewnych sekcji można zachować lokalne kopie pojedynczych obrazów
lub filmów. W przypadku korzystania z domyślnej ścieżki instalacji zatrzymane obrazy i filmy są
przechowywane w katalogu C:\BOSCH\Access Professional Edition\PE\Data\Video.

Klikając przycisk , można zapisać zatrzymany obraz w formacie JPG pod nazwą <nazwa
urządzenia>_rrrrMMddggmmsstttt.jpg
[r = rok, M = miesiąc, d = dzień, g = godzina, m = minuta, s = sekunda, t = tysięczne sekundy].

Naciśnij przycisk , aby rozpocząć zapis bieżącej sekwencji, i naciśnij ponownie, aby
zakończyć sekwencję. Ta lokalna kopia zapisu wideo jest nazywana w ten sam sposób jak
obrazy i przechowywana w formacie .vxx lub .mpeg. Format .vxx nie może być przeglądany tak
samo jak filmy do zastosowań w standardowych warunkach rynkowych. Do przeglądania tych
lokalnych kopii służy znajdujący się w zestawie program Bosch Video Player (Odtwarzacz
wideo firmy Bosch).

Klikając przycisk , można zapisać zatrzymany obraz bieżącego widoku punktu
zainteresowanie (POI). Do początku nazwy pliku dodawany jest przedrostek _POI: _POI
<nazwa urządzenia>_rrrrMMddggmmsstttt.jpg.
[r = rok, M = miesiąc, d = dzień, g = godzina, m = minuta, s = sekunda, t = tysięczne sekundy].
Jako znacznik tworzony jest też komunikat dziennika.

Bosch Video Player (Odtwarzacz wideo firmy Bosch)
Podczas gdy zatrzymane obrazy można otworzyć za pomocą praktycznie dowolnej przeglądarki
plików graficznych lub przeglądarki internetowej, zapisy wideo mają specjalny format i
wymagają odtwarzacza Bosch Video Player.

Uwaga!
Do wyświetlania sekwencji wideo zapisanych w formacie MPEG można użyć dowolnego
odtwarzacza.

Okno dialogowe nie jest skomplikowane, ma tylko dwa przyciski obok pola wyświetlacza,
mianowicie open file (otwórz plik) i start/stop.
Naciśnięcie przycisku open file (otwórz plik) umożliwia przeglądanie domyślnego miejsca
przechowywania nagrań wideo (C:\) w celu wyszukania wymaganych plików.
Ścieżka wybranego pliku wideo jest wyświetlana w odtwarzaczu Video Player. W dowolnym
momencie można wyświetlić wybrany plik, naciskając start. Podczas odtwarzania filmu
przycisk start zmienia się w stop, aby umożliwić przerwanie odtwarzania.
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8 Konfigurowanie uprawnień użytkownika
Standardowe konto administratora systemu ma jako nazwę użytkownika i hasło bosch. Należy
natychmiast nadać temu kontu silne hasło i użyć go do skonfigurowania kont administratora i
kont nieuprzywilejowanych z użyciem silnych haseł.
Uprawnienia do korzystania z aplikacji systemu Access PE (jak również z aplikacji Configurator
(Konfigurator) i Log Viewer (Analiza dziennika)) są przydzielane w aplikacji Personnel
Management (Zarządzanie personelem) na specjalnej karcie Danych osobowe i
uwierzytelnianie > Uprawnienia użytkownika.
 Ta karta jest widoczna tylko dla użytkowników mających uprawnienia administratora. Tylko
administratorzy mogą przydzielać i zmieniać uprawnienia własne oraz innych użytkowników
swojej grupy.

Aby dana osoba otrzymała uprawnienia do korzystania z aplikacji Access PE na stanowiskach
pracy, muszą one zostać przydzielone jawnie. W ustawieniach standardowych wszystkie osoby
są wprowadzane bez uprawnień użytkownika.
Uprawnienia użytkownika przydzielane są po wpisaniu nazwy użytkownika oraz hasła.
Proponowana zwykle nazwa użytkownika to nazwisko osoby, jednak opcjonalnie można ją
zmienić. Hasło może zawierać maksymalnie 16 znaków, w tym wszystkie znaki specjalne,
rozróżniana jest wielkość liter.

Uwaga!
Zapewnienie odpowiedzialności
Należy używać indywidualnych, a nie ogólnych kont użytkowników. Wszystkie pozycje i
modyfikacje danych są rejestrowane z nazwą użytkownika. Należy upewnić się, że użytkownicy
wykonują przekazywanie po zakończeniu swojej zmiany.
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Administratorzy różnią się od zwykłych użytkowników tym, że mogą przydzielać uprawnienia.
Jeśli chodzi o dostępność poszczególnych aplikacji oraz możliwość edycji zestawów danych i
dzienników, nie ma różnicy między rodzajami użytkowników. Wszyscy nowi użytkownicy mogą
zostać skonfigurowani z ograniczonym lub nieograniczonym dostępem do danych.
Można aktywować następujące uprawnienia użytkownika:

Apli-
kacja

Uprawnienie
użytkownika

Opis

Personnel
data (Dane
osobowe)

View personnel
data
(Wyświetlanie
danych
osobowych)

Można otworzyć tylko okno dialogowe zawierające dane osobowe. Lokalizacja nie
zostanie ujawniona. Edycja jest niemożliwa.

Edit personnel
data (Edycja
danych
osobowych)

Dane osobowe można przeglądać i edytować. Lokalizacja nie zostanie ujawniona.

Change location
(Zmiana
lokalizacji)

Może zostać przydzielone jedynie w połączeniu z jednym z wyżej wymienionych
uprawnień.
W połączeniu z uprawnieniem View personnel data (Wyświetlanie danych
osobowych) możliwe jest tylko wyświetlanie lokalizacji.
W połączeniu z uprawnieniem Edit personnel data (Edycja danych osobowych)
możliwe jest modyfikowanie lokalizacji.

Change
authorizations
(Zmiana
uprawnień)

Karta Access authorizations (Uprawnienia dostępu) zostanie wyświetlona dopiero
po zaznaczeniu tego pola wyboru.

Configurat
or
(Konfigurat
or)

Configuration of
system
(Konfigurowanie
systemu)

Umożliwia uaktywnienie pełnych uprawnień do przeprowadzania edycji w
narzędziu Configurator (Konfigurator).

Door
manageme
nt
(Zarządzani
e
drzwiami)

Open /lock door
(long-term)
(Otwieranie/
zamykanie drzwi
(na stałe))

Uaktywnienie funkcji Door management (Zarządzanie drzwiami w menu o tej
samej nazwie lub w menu kontekstowym listy statusu urządzeń (w aplikacjach
Personnel management (Zarządzanie personelem) i Log Viewer (Analiza
dziennika)).

Log Viewer
(Analiza
dziennika)

View own
message
(Wyświetlanie
komunikatów
dotyczących
własnej osoby)

Powoduje selekcjonowanie komunikatów analizy dziennika i wyświetlanie tylko
tych, które dotyczą samego użytkownika.

View all
messages
without

Powoduje wyświetlanie wszystkich komunikatów, ale z ukrywaniem w nich danych
osobowych.
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Apli-
kacja

Uprawnienie
użytkownika

Opis

personal data
(Wyświetlanie
wszystkich
komunikatów
bez danych
osobowych)

View all
messages
(Wyświetlanie
wszystkich
komunikatów)

Umożliwia wyświetlanie wszystkich komunikatów bez ukrywania w nich danych
osobowych.

Procedura konfigurowania nowych użytkowników
1. Uruchom aplikację Personnel Management (Zarządzenie personelem) systemu Access PE

za pomocą ikony  na pulpicie, a następnie zaloguj się na wstępnie
skonfigurowanym koncie Użytkownika-Administratora.

2. Otwórz okno dialogowe dodawania danych personelu za pomocą przycisku  lub
menu Persons > New Person (Osoby > Nowa osoba)

3. Dodaj nowego użytkownika, określając przynajmniej jego nazwę i grupę personelu
4. Kliknij kartę User Rights (Uprawnienia użytkowników) oraz:

– w razie konieczności zmień nazwę użytkownika;
– przypisz hasło;
– zdefiniuj rodzaj użytkownika — User (Użytkownik) lub User-Administrator

(Użytkownik-Administrator);
– przypisz użytkownikowi uprawnienia do modyfikacji danych;
– potwierdź ustawienia i zamknij okno dialogowe, klikając przycisk OK.

5. Wyloguj się z aplikacji Personnel Management (Zarządzanie personelem), klikając przycisk

 lub korzystając z menu Extras > Logon (Dodatki > Logowanie) i podczas kontroli
bezpieczeństwa odpowiadając Yes (Tak).

6. Za pomocą przycisku  lub menu zaloguj się ponownie, korzystając z danych
użytkownika, który został właśnie utworzony.

8.1 Zmiana użytkownika i bezpieczeństwo stacji roboczej
Zmiana użytkownika
Jeśli jeden z użytkowników rezygnuje z używania stacji roboczej na rzecz innego użytkownika,
powinien wykonać formalne przekazanie. Gwarantuje to, że wszystkie działania zostaną
prawidłowo przypisane do użytkownika, który je wykonał.
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1. W pierwszej kolejności musi się wylogować dotychczasowy użytkownik. W tym celu należy

kliknąć przycisk  na pasku narzędzi. Pojawi się pytanie: Do you want to end your
work with user rights? (Czy chcesz zakończyć pracę z uprawnieniami użytkowników?).

2. Po potwierdzeniu system przełącza się z powrotem do głównego okna dialogowego
aplikacji.

3. Nowy użytkownik loguje się ponownie za pomocą przycisku .

Bezpieczeństwo stacji roboczej
Zabezpieczenie danych osobowych przed nieuprawnionym dostępem na czasowo
niezajmowanej stacji roboczej. W tym celu dostępnych jest kilka możliwości:
– Zasadniczo na tych komputerach nie należy instalować aplikacji Configurator

(Konfigurator) ani Log Viewer (Analiza dziennika).
– Wylogowanie z aplikacji Personnel Management (Zarządzanie personelem), gdy nie jest

ona używana, poprzez użycie przycisku  i powtórzenie opisanej powyżej kontroli
bezpieczeństwa. Lista osób będzie nadal widoczna, ale nie będzie możliwe przeglądanie
danych.

– Zamknięcie aplikacji za pomocą poleceń File > Exit (Plik > Zakończ) lub przycisku x na
pasku tytułu okna aplikacji w systemie Windows. Aby wyświetlić listę osób, należy
ponownie uruchomić aplikację.

– Zablokowanie komputera za pomocą standardowej funkcji systemu Windows: należy
nacisnąć kombinację klawiszy Ctrl + Alt + Del i z wyświetlonych funkcji systemowych
wybrać Zablokuj ten komputer. Jest to opcja domyślna, więc funkcję Zablokuj ten
komputer można szybko uruchomić, naciskając klawisz ENTER. W takim przypadku
komputer może odblokować tylko aktualny użytkownik lub administrator systemu
Windows.
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9 Wyzwalanie i anulowanie alertów o zagrożeniu
Wstęp
Zagrożenie jest to sytuacja krytyczna, która wymaga natychmiastowej i równoczesnej reakcji
na niektórych lub wszystkich wejściach w systemie kontroli dostępu.
Threat alert (Alert zagrożenia) to alarm w reakcji na zagrożenie. Zależnie od ustawień wejść w
aplikacji Access PE Configurator są możliwe różne sposoby reagowania na alerty zagrożenia.
Odpowiednio uprawnione osoby mogą dokonywać alertu zagrożenia z jedną akcją, np. za
pośrednictwem interfejsu użytkownika aplikacji Access PE, naciskając przycisk lub
przedstawiając specjalną kartę identyfikacyjną przed dowolnym czytnikiem.

Wymagania wstępne
– Aby umożliwić reagowanie na alert o zagrożeniu, sprzęt systemowy musi zostać

skonfigurowany w programie Configurator. Szczegółowe informacje na ten temat można
znaleźć w poniższych sekcjach pomocy programu Configurator:
– Przypisanie sygnału wejściowego do alertu o zagrożeniu
– Definiowanie odpowiedzi wejść na alarm o zagrożeniu

– Aby można było ustawić lub dezaktywować alert zagrożenia za pomocą okien dialogowych
programu Access PE, użytkownik okna dialogowego musi mieć prawo otwierania/
blokowania drzwi (długotrwałe). 
W programie Access PE Configurator kliknij dwukrotnie okno dialogowe użytkownika na
liście głównej personelu > Dane osobowe i uprawnienia > Prawa użytkownika i zaznacz
pole wyboru Otwórz / zablokuj drzwi (długotrwale).

– Każda osoba może za pomocą sprzętu (np. przycisk) lub poprzez kartę alertów zagrożenia
ustawić alert, jeśli ma do nich fizyczny dostęp.

Przegląd
Użytkownik systemu Access PE może wyzwolić alert zagrożenia, klikając przycisk Ustaw alert
zagrożenia w oknie programu: Zarządzanie alarmami, Zarządzanie personelem i Analiza
dziennika.
Każda osoba może wyzwolić alert zagrożenia w jeden z poniższych sposobów:
– Za pomocą przycisku lub innego przełącznika połączonego z sygnałem wejściowym AMC,

który został przypisany do alertu o zagrożeniu w aplikacji Access PE Configurator.
– Przedstawiając specjalną kartę alertów w dowolnym czytniku dostępu.

Tylko odpowiednio autoryzowany użytkownik systemu Access PE może dezaktywować alert
zagrożenia, klikając przycisk Dezaktywuj alert zagrożenia w jednej z aplikacji. Ze względów
bezpieczeństwa alertów nie można anulować za pomocą karty alertów zagrożenia.

9.1 Za pomocą przycisków Ustaw/Dezaktywuj alert zagrożenia
Przycisk Ustaw alert zagrożenia jest umieszczony w widocznym miejscu na ekranach
głównych następujących aplikacji Access PE:
– Zarządzanie personelem
– Zarządzanie mapami i alarmami
– Log Viewer (Analiza dziennika)

<->
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Procedura
1. Kliknij przycisk Ustaw alarm zagrożenia i potwierdź w oknie wyskakującym.

Przycisk zmieni się na Dezaktywuj alert zagrożenia.
2. Po rozwiązaniu sytuacji powodującej zagrożenie kliknij przycisk Dezaktywuj alert

zagrożenia i potwierdź w oknie wyskakującym. 
Przycisk zmieni się ponownie na Ustaw alert zagrożenia.

Uwaga!
Drzwi zablokowane (zabezpieczone)
Po zdezaktywowaniu alertu przyciskiem Deactivate Threat Alert (Dezaktywuj alert
zagrożenia) drzwi, które zostały jawnie ustawione w stan drzwi zablokowane (zabezpieczone)
pozostaną nadal zabezpieczone. W celu uniknięcia dodatkowych naruszeń zabezpieczeń po
wystąpieniu alertów o zagrożeniu, konieczne jest jawne dezaktywowanie stanu zabezpieczenia
drzwi.
Ścieżka dostępu:
ekran główny aplikacji Personnel Management > drzewo Device states (Stany drzwi) >
kliknij w menu kontekstowym prawym przyciskiem myszy zabezpieczone wejście (oznaczone
za pomocą kłódki).

9.2 Karty alertów zagrożenia
Przegląd
Karta alertów zagrożenia to specjalne poświadczenie, które może być przypisane do
dowolnego posiadacza karty przez administratora użytkowników (to znaczy przez każda osobę
mającą uprawnienia użytkownika do konfigurowania i modyfikowania osób w systemie Access
PE).
Karta alertów zagrożenia nie zapewnia dostępu przy wejściach, ale powoduje wyzwalanie
alertu o zagrożeniu, jeśli jest przedstawiana przed dowolnym czytnikiem kart w systemie
Access PE.
Kartą alertów zagrożenia nie można dezaktywować alertów zagrożenia. Administratorzy
systemu mogą dezaktywować alerty zagrożenia, klikając przycisk Dezaktywuj alert zagrożenia,
znajdujący się na ekranach głównych następujących aplikacji Access PE:
– Zarządzanie personelem
– Zarządzanie mapami i alarmami
– Log Viewer (Analiza dziennika)

Przydzielanie kart alertów zagrożenia osobom
1. Zaloguj się w aplikacji Zarządzanie personelem jako użytkownik administrator.
2. Na liście posiadaczy kart identyfikacyjnych kliknij dwukrotnie posiadacza karty, dla

którego ma zostać przypisana karta alertów zagrożenia.
Otworzy się okno dialogowe Dane osobowe i uwierzytelnianie.

3. Wybierz kartę Dane osobowe.
4. Kliknij przycisk Przydziel kartę do uaktywniania alertu zagrożenia
5. Następny krok zależy od tego, czy jest dostępny czytnik rejestracji:

– Jeśli na stacji roboczej skonfigurowano czytnik rejestracji, należy postępować
według zwykłej procedury przypisywania karty osobie.
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– Jeśli nie skonfigurowano czytnika rejestracji, konieczne będzie ręczne wprowadzenie
danych karty.

Obie procedury są opisane w sekcji Przydzielanie i odbieranie kart
identyfikacyjnych. Patrz link na końcu tej sekcji.

Karta z odpowiednimi wewnętrznymi informacjami o karcie spowoduje teraz wyzwolenie alertu
zagrożeniu, jeśli zostanie przedstawiana w dowolnym z czytników kart systemu.

Usuwanie przydzielonych kart alertów zagrożeń
1. Na liście posiadaczy kart identyfikacyjnych kliknij dwukrotnie posiadacza karty, od

którego ma zostać odebrana przypisana karta alertów zagrożenia.
Otworzy się okno dialogowe Dane osobowe i uwierzytelnianie.

2. Wybierz kartę Dane osobowe.
3. Kliknij przycisk Usuń kartę do uaktywniania alertu zagrożenia
4. Potwierdź usunięcie w oknie wyskakującym.

Karta przedstawiana w dowolnym czytniku kart nie będzie już wyzwalać alertu zagrożenia.

Więcej informacji
– Przydzielanie i odbieranie kart identyfikacyjnych, Strona 38
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10 Wymagania normy UL 294
Funkcje, które nie zostały ocenione przez firmę UL:
– System weryfikacji wideo
– Przeglądanie map i zarządzanie alarmami z weryfikacją map i wideo
– Odtwarzacz wideo
– Badge Designer (Projektant identyfikatorów)
– Modele Delta 1200 Series
– Modele Rosslare ARD-1200EM Series
– Kontrolery LAC
– Kontrolery LACi
– Kontrolery APC-AMC2-4R4CF

– Protokół interfejsu czytnika BG 900
– Protokół interfejsu czytnika L-BUS

– System sygnalizacji włamania — uzbrajanie/rozbrajanie
– Używanie windy
– SMS-y
– Dziennik
– Zarządzanie personelem
– Tworzenie kart
– Raporty
– Uprawnienia użytkownika
– Używanie alarmu włamaniowego

Funkcje ocenione przez firmę UL:
– Czytniki w 26-bitowym formacie Wiegand
– Kontrolery AMC2:

– APC-AMC2-4WCF
– API-AMC2-4WE
– API-AMC2-8IOE
– API-AMC2-16IOE

– APE-SW jako dodatkowy sprzęt monitorujący
Następujące modele czytników kart firmy Bosch zostały ocenione przez firmę UL pod kątem
zgodności z systemem oprogramowania APE-SW firmy Bosch:
– LECTUS secure 1000 WI
– LECTUS secure 4000 WI
– LECTUS secure 5000 WI
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